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Chapter 1:  
What’s New 

This DataNet user guide supports the following DataNet CFR 
release: 
• Software version 2.0.0.0 
• Firmware version 2.30 
• New hardware units: DNL804, DNL910-PA, DNL920-PA  
 
Prominent new features included in this user guide are 
outlined below.  

DataNet CFR Software v2.0.0.0 

Note: Following installation of DataNet v2.0.0.0, the software 
will run in Trial mode until activated using a unique software 
Serial Number. Trial mode lasts 30 days before software is 
deactivated. Software license is good for unlimited 
installations on one computer only. Please contact your local 
vendor for further information. 

• Language support: English, Italian, French and Spanish  
• New Reports module: 

• Generate any type of report including alarm, events, 
SMS and e-mail notification, graphs and histogram 
logs 

• Report can be generated periodically and 
automatically by e-mail 

• Report can be exported in CSV and/or PDF file format 
• Easy navigation of logger data using up and down 

scroll buttons 
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• Report browsing capabilities 
• Enhanced report editing for compatibility with CFR 

requirements 
• Map View: 

 Added ability to add name tag for each device on Map 
View 

 Added ability to print the Map View screen, including 
name tags (if enabled)  

 Added Turn Off command to Logger menu 
 Added multi-logger functionality: Run, Stop and Turn 

Off 
• Sensor View:  

 Added indication when data is being downloaded and 
added S/N to the tooltip 

 Added a scroll bar to ease the sensor navigation    
• History View:  

 Improved History View while opening a saved data file 
 Added customizable Graph, Table and Statistics 

header  
• Analysis:  

 Added calculation of MKT (Mean Kinetic 
Temperature) 

 Improved Histogram view 
• Logger Alarm mechanism: In event of logger alarm 

while PC is offline, the software will send alarm 
notification when the PC is next online 

• SMS and e-mail notifications: Modified notification 
format 
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• Saving Data files: Added alternative path for saving data. 
If user defined path is offline the system will use the 
default path to save logger data 

• Software update module: Improved GUI and 
functionality 

• Various bugs fixes 
 
Known Software Issues: 
• No support of online change of daylight saving time 
• When software is closed the scheduled reports cannot be 

generated and sent   
 

DataNet Firmware v2.30 
• Support for new DataNet product family:  

 DNL804 (4-20 mA) 
 DNL910PA (same functionality as DNL910 but with 

Power Amplifier) - must be connected to external 
power supply  

 DNL920PA (same functionality as DNL 920 but with 
Power Amplifier) - must be connected to external 
power supply  

• Added Substitute Receiver feature allowing for Repeater 
to replace the network Receiver in even of Receiver 
failure, thereby allowing data download  

• Added USB data download support from logger to 
computer (not supported on Mini DataNet models) 

• Added support for firmware update via USB (not 
supported on Mini DataNet Models) 

• Increased data logger sampling rate to once every 18 
hours, from once every two hours in previous versions 
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• Improved power consumption for all new and current 
DataNet hardware, extending the battery life 

• Improving charging mechanism (battery charging 
hysteresis) 

• Change in LED functionality of Mini DataNet units 
(DNR800, DNL804, DNL808 and DNL810)  

• Improved ZigBee network communication resulting in 
faster and more efficient handling of wide network 
deployment 

• Various bugs fixes 
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Chapter 2:  
DataNet Overview 

This chapter provides a general overview of the DataNet 
system as well as the concept behind the ZigBee RF protocol. 

2.1. DataNet Introduction 

The Wireless Intelligent Logging Network 
Fourier Systems next generation data logging system is the 
DataNet, a 16-bit, mobile data acquisition network based on 
the innovative and reliable ZigBee technology. This solution 
provides an intelligent sensor mesh system with 100% data 
receipt and no data loss.   
The DataNet system is comprised of a family of data logging 
units, as well as a Receiver to manage the intelligent network 
and Repeaters to extend the transmission range. The data 
loggers measure a broad range of parameters and include 
models that feature between one and four inputs for direct 
measurement and recording of PT-100, thermocouple, 0 to 1 
V, 4 to 20 mA, contact, frequency and pulse sensors, as well 
as internal temperature and relative humidity sensors. These 
models range from loggers with graphic display, AC or battery 
power supply, and power amplification, to models with no 
display and battery power only.  
Data is transmitted from the end units to a Receiver 
connected to a central computer. The system leverages the 
ZigBee protocol, a 2.4 GHz license-free frequency RF band, 
to ensure full data integrity. By adding DataNet Repeater units 
or loggers with power amplification to the network, you can 
extend the transmission range and form a reliable mesh 
network of up to 65,000 units. 
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With its high resolution and fast Analog to Digital converter 
(ADC), DataNet data loggers meet the majority of data 
acquisition requirements in most industrial applications. Every 
DataNet logger unit is embedded with a unique serial number 
and can be loaded with a descriptive comment for safe 
identification. An internal clock and calendar keeps track of 
the time and date of every sample measured. 
DataNet loggers can automatically activate external alarm 
events when data is outside a specified range. Email and 
SMS notifications can be sent to predefined contacts.  
The DataNet system is powered by the powerful DataNet 
software. The Windows ™ based software is the central 
management interface of the DataNet network. Data is 
monitored online and can be displayed in graphs or tables. 
You can analyze data with various mathematical tools, or 
export data to a spreadsheet. Detailed reports can also be 
generated from the system, collating a wealth of relevant 
system data. 
The software also enables you to configure, calibrate or 
update the firmware of DataNet units wirelessly.  
 

Key DataNet benefits include: 
• Reliable transmission ensuring no data loss 
• Long-range monitoring 
• Ability to constantly expand transmission range by adding 

additional Repeaters, or turning loggers into Repeaters 
• Portable units facilitating easy deployment in various 

environments 
• Remote programming and firmware updates  
• 65,000+ possible end units 
• 16-bit resolution 
• Low-power consumption 
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• Long battery life 
• Minimal costs thanks to wireless infrastructure 
• Feature-rich software 

2.2. DataNet CFR Compliancy 

To achieve compliance with FDA Title 21 CFR Part 11, use 
Fourier Systems’ software package: DataNet CFR together 
with DatPass, Fourier Systems’ Administrative software. 
Among other features, it defines the users that can log into the 
DataNet software, their passwords and the digital signatures 
the users are permitted to sign data within electronic records 
(files). DatPass also maintains an audit trail to keep track of all 
actvities performed within the system and user privileges can 
be defined as well. The system is secured with a USB port 
dongle, without which the DatPass and DataNet software 
packages will not operate. 
Refer to the DataNet user guide for more information. 
To learn how to login to the DataNet CFR software, go to 
page 109. 

2.3. What is ZigBee? 

ZigBee is a standards-based protocol built around the IEEE * 
802.15.4 wireless protocol, providing the network 
infrastructure required for wireless, low power network 
applications.  
The mesh network eliminates single points of failure by 
providing multiple pathways for data to travel. 
* IEEE is the Institute of Electrical and Electronics Engineers, 
a non-profit organization dedicated to furthering technology 
involving electronics and electronic devices. 
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2.4. The ZigBee Concept 

The Coordinator: This device creates and maintains the 
network. Once the network is up and running, the coordinator 
behaves as just another device on the network. There is only 
one Coordinator in a ZigBee network.  
The Router: A router relays data packets/messages between 
devices on the network and increases the distance between 
these devices.  
The End Unit: This device sends and receives information to 
other devices on the network. It is usually a control or a 
sensor unit, often battery operated. A ZigBee end unit cannot 
relay messages.  
ZigBee Terminology DataNet Terminology 
Coordinator Receiver 
Router Repeater 
End Unit Data Logger 
 
ZigBee enables mesh networking which supports a wireless, 
yet integrated environment with communication between 
many coordinators, routers and end units in environments 
where multiple applications are being monitored.  
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2.4.1. ZigBee Mesh Network 
Operation 

 

 
Figure 1: ZigBee network diagram 
In a mesh network, all the router units are aware of their 
environment meaning a router knows with units are close by. 
When a router sends a message to a specific unit, it relays the 
message until it gets to the destination. 
Network recovery from a unit failure 
In a mesh network, when a router fails, the network 
automatically finds a different path via a different router for the 
message relay. 
This ensures maximum protection against a network 
breakdown. 

2.4.2. Why is ZigBee Technology Key 
for Data Logging? 

ZigBee technology has proved to be ideal for data acquisition 
networks which require meter reading, parametric display of 
data such as temperature or humidity and responsive action 
when parameters are crossed. This is due to the fully 
automated, flexible and reliable nature of the protocol. With 
the Mesh Network system, the ZigBee standard redresses 
misbalances in any data logging system, responding to 
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weaknesses, inefficiencies, new network structure (with the 
additional or removal of devices) through self correction.  

2.5. The DataNet System  

The basic DataNet system will contain at least one of the 
following units: 
• DataNet data logger – Part Number DNL804, DNL808, 

DNL810, DNL910, DNL920, DNL910-PA, DNL920-PA 
• Receiver/Repeater unit – Part Number DNR900 
• Mini Repeater – Part Number DNR800 
• Mini-USB cable  
• Power adapter (one per DataNet unit ordered) 
• DataNet Software CD with unique serial number 

2.5.1. The Data Logger  

There are seven distinct data logger models compatible with 
the DataNet system. These are the so-called end units of the 
system. These loggers support up to four external sensors 
and two internal sensors, temperature and humidity, 
depending on the specific model. Data is recorded and stored 
to the logger’s internal memory and transmitted over the 
network to the DataNet software running on the PC.  
The data logger is programmed to consume as little power as 
possible during operation, in order to conserve the battery life. 
When not transmitting or recording data the units are in sleep 
mode and they wake up when needed.  
The battery for the DNL910 and DNL920 is rechargeable and 
can run up to several months on one charge, depending on 
the logger configuration.  
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The DNL910-PA and DNL920-PA loggers include power 
amplification (PA), enabling longer transmission range 
compared to the non-PA units, and as a result have high 
power consumption. The PA units therefore must be 
connected to AC power at all times otherwise its battery will 
drain after a few hours.  
The battery for the DNL804, DNL808 and DNL810 is not 
rechargeable and can run up to ten months before being 
replaced, depending on the logger configuration. 
Refer to section  4.9.6 for more information.  

Note: Battery life depends on the logger sampling rate, 
transmission rate, type of sensor, network architecture and 
number of measured sensors. 

The seven DataNet models can be divided into two groups:  
• DataNet loggers (with LCD) 
• Mini DataNet loggers (without LCD) 

DataNet Loggers (with LCD) 

   

Part Number: DNL920 and DNL920-PA Part Number: DNL910 and DNL920-PA 
Four external channel RF data logger 
with two internal sensors, Humidity and 
Temperature. 

Four external channel RF data logger 
with internal Temperature sensor. 
* PA model includes Power Amplifier for 
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* PA model includes Power Amplifier for 
long-range transmission.  

long-range transmission. 

Transmission Range:  
DNL920: 4 dBm 
DNL920-PA: 15 dBm 
Memory Capacity: ~59,000 samples 
Power supply: AC or battery operated 

Transmission Range:  
DNL910: 4 dBm 
DNL910-PA: 15 dBm 
Memory Capacity: ~59,000 samples 
Power supply: AC or battery operated 

 
Mini DataNet Loggers (without LCD) 

 
  

 

 
PN: DNL804 PN: DNL810 PN: DNL808 
Single channel RF data 
logger supporting external 
4 to 20 mA  input 

Dual channel RF data 
logger with internal 
Temperature and Humidity 
sensors. 

Single channel RF data 
logger supporting 
external temperature 
NTC 10KΩ probe 

Transmission Range:  
4 dBm 
Memory Capacity: 

Transmission Range:  
4 dBm 
Memory Capacity: 

Transmission Range: 
4 dBm 
Memory Capacity: 
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~59,000 samples 
Power supply: Battery 
operated 

~59,000 samples 
Power supply: Battery 
operated 

~59,000 samples 
Power supply: Battery 
operated 

2.5.2. The Receiver/Repeater  

Note: The DNR900 can work in one of two modes, Receiver 
or Repeater. The DNR800 only works as a Repeater. 

The Receiver, DNR900, acts as a bridge between the 
DataNet network and the PC. It is connected to the PC via 
USB cable and is used to create the network to which you add 
your data loggers. The Receiver is externally powered but 
also includes a rechargeable battery for back up (in case the 
external power fails). 

Note: Each Receiver can detect up to 8 data loggers and 16 
Repeaters. To detect more data loggers, Repeaters are 
required. 

The Repeater is considered the backbone of the network, as 
it enhances the network range by receiving and transmitting 
between end unit and Repeater until it reaches the PC. There 
are two Repeater models, the DNR900 with LCD and the 
DNR800 Mini Repeater, without LCD. Both are externally 
powered via the AC adapter but the DNR900 also includes a 
rechargeable battery back up (in case the external power 
fails).  
The Repeaters are the end units’ parent units, meaning each 
Repeater has specific end units under their responsibility 
(their children). They route the transmissions to and from the 
end units to the Receiver (or other Repeaters in the network).  
Each Repeater holds the data sent to the end units while the 
end units are in sleep mode. At a specific interval the end unit 
wakes up and receives the data from its parent (Repeater). 
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Note: Each Repeater can detect up to 24 data loggers and 16 
Repeaters including the parent unit. If the number of loggers 
exceeds this capability, additional Repeaters are required. 

Receiver/Repeater with LCD 

 

Part Number: DNR900 
Repeater Transmission Range: 15 dBm 
End Units per Receiver: ~65,000 

 



 
 

15 

Mini Repeater (without LCD) 

 

Part Number: DNR800 
Repeater Transmission Range: 10 dBm 
End Units per Receiver: ~65,000 

2.5.3. Hardware Accessories 

The DataNet system includes the following accessories: 
• Mini-USB cable for connecting PC to DataNet Receiver 
• Power adapter to power DataNet Receiver, Repeater and 

data loggers 
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2.5.4. DataNet Software  

The user interface for the DataNet system, the DataNet 
software CD is provided together with the DataNet hardware 
and includes the following features: 
• Network management 
• Data display, management, storage and data diagnostics 
• Alarm settings: Email and SMS notifications, visual and 

audible alarms 
• Reports module 
• Wireless sensor definition  
• Wireless sensor calibration  
• Wireless firmware update (boot over the air) 
• Data download via USB  
• Automatic software update (via Fourier server) 
 
The software interface is described in detail in  Chapter 5: 
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Chapter 3:  
DataNet 
Implementation Guide  

Fourier Systems strongly suggests first time users of the 
DataNet system read this chapter before drilling down into the 
many features of the system described later in the user guide. 
The Implementation Guide will give you a clear understanding 
of the basic aspects of setting up the system, and getting your 
network up and running.  
Once you are familiar with the technical aspects of setting up 
the network as outlined in this chapter, please consult section 
 3.8 for Fourier’s recommended approach to initial deployment 
of the system. 
Example 
Below is a diagram depicting a supermarket deployment of a 
DataNet system, illustrating how the devices may be 
positioned to provide full coverage within the facility. 

 
Figure 2: Example of DataNet network application 
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3.1. DataNet Network 
Architecture 

The DataNet network architecture consists of layers of loggers 
and Repeaters, forming a mesh network monitored by the 
Receiver unit connected to the workstation PC. 
The basic architecture is as follows: 
• Maximum nodes on network: 65,000 
• DNR900 Receiver recognizes up to 8 loggers and 16 

Repeaters 
• DNR900 Repeater and DNR800 Mini Repeater 

recognizes up to 24 loggers and 16 Repeaters (including 
parent unit) 

• DNL910 and DNL920 (including the PA models) in Short 
Range Repeater mode (refer to section  3.8.5) recognizes 
up to 24 loggers and 16 Repeaters 

The diagrams below show the architecture of a typical 
DataNet mesh network. Repeaters and loggers, which are 
being used as Short Range Repeaters in Figure 4 (see 
section), can be added to the network in order to extend the 
range and improve its robustness. Each such device has end 
units communicating with it, but this route may change as the 
RF environment changes. This is the ZigBee self correcting 
mechanism at play.     
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Figure 3: Standard DataNet mesh network architecture 
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Figure 4: DataNet network with Short Range Repeaters 
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3.2. Pre-setup Requirements 

Prior to commencing with the DataNet implementation you 
must have the following requirements in place: 
PC 
• 24/7 availability 
• Reliable AC power 
• Sufficient hard disk space to store loggers’ data 
• One free USB port 
 
DataNet devices 
• One DNR900 DataNet Receiver 
• At least one DataNet logger DNL910, DNL920, DNL910-

PA, DNL920-PA, or Mini DataNet logger DNL804, 
DNL808 or DNL810 

• At least one DNR900 DataNet Repeater or DNR800 Mini 
Repeater, depending on your RF environment  

 
Mini-USB cable 
The mini-USB cable connects the DNR900 Receiver to the 
PC (and is supplied with the PC Suite software kit). 

3.3. Launching the Software 

1. Install the DataNet software on the PC workstation. Refer 
to section  5.1: Installing DataNet Software on page 104 
for more details. 

 



 
 

21 

2. Once the software and associated components have 
been installed, launch DataNet from your DataNet 

desktop shortcut . 
3. Software activation window will open. Select the option to 

continue to DataNet and click Next. To activate the 
software refer to chapter  5.2. 

 
Figure 5: Software activation window 

4. The main DataNet window is launched. The default view 
is called Map View. 
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Figure 6: Main DataNet window 

5. Check for DataNet updates. Go to Help > Check for 
Updates from the DataNet main menu to check for newer 
versions of DataNet software and firmware released since 
you purchased your system. For more details on the 
Update feature go to  Chapter 6: Updating DataNet 
Software and Firmware. 

3.4. Connecting the Receiver 

1. Only once the DataNet software has been installed, 
connect the DataNet Repeater unit (DNR900) to the 
Fourier-supplied power adapter.  

Note: Only use adapters provided by Fourier Systems. Use of 
the wrong adapter could damage your DataNet units.  
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2. Turn on the unit by pressing the Scroll button  on 
the front keypad. The unit will beep when turned on. 

3. Verify that the unit is in Receiver mode by seeing the 
following screen on the LCD:  

 
The ID will be unique to your Receiver network. If the unit 
is in Repeater mode, switch it to Receiver mode. Go to 
section  4.15 for more details. 

4. Connect the mini-USB cable to the computer and to the 
Receiver’s mini-USB port. The DataNet Receiver icon 

 will immediately appear in the top left corner of the 
Map View. 

 
Figure 7: Adding Receiver icon to Map View 
A green icon indicates that the Receiver is online.  

Note: If the Receiver is not recognized by the software try 
connecting the mini-USB cable to another USB port on the 
PC. Or select Network > Detect Receiver in the main menu. 

Receiver 
ID: 123.456.789 
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Should you disconnect the Receiver’s USB cable or 
power adapter (and the battery eventually dies), the 

Receiver icon will be grayed out:   
5. Go to Network > Form New Network. The Receiver will 

then form a new network based on your RF environment 
rather than use the network formed in the factory. This will 
ensure optimal network performance. Refer to section  3.8: 
Optimizing the Network for more details. 
Check the DataNet network ID that was formed by the 
Receiver by placing the mouse cursor over the Receiver 
icon. The network ID as well as Receiver firmware version 
and unit serial number is displayed. 

 
Figure 8: Receiver tooltip  

Note: You can move the Receiver icon elsewhere on the 
screen by going to Tools > Lock Map View and unselecting 
this option. 

3.5. Adding the Data Logger to 
the Network 

Once you have connected your Receiver and established a 
network you are ready to add data loggers and build your 
system. 
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3.5.1. Charging DataNet Loggers 

This section refers to charging the DNL910 or DNL920 
loggers. The Mini DataNet units are battery operated only. 

Note: Only use adapters provided by Fourier Systems. Use of 
the wrong adapter could damage your DataNet units.  

 

Note: DataNet units do not charge when switched off. 

 
If the loggers will run from the battery supply make sure to first 
charge each of the loggers for 16 hours before use in order 
maximize the battery life. A fully charged battery can last 
several months, depending on your logger configuration. 
Refer to section  4.9.6 or more details on battery life. 
If the loggers will run from the AC power supply, when first 
connected to the AC adapter the logger will always initiate the 
16 hour charge cycle.  
However, if you reconnect the AC charger within one hour of 
disconnection from the unit, the logger will not start a new 16 
hour charging cycle as long as battery level is at least 90%. 
 

Note: For loggers measuring data with the internal 
temperature sensor, it is critical to note that during the charge 
cycle the logger will heat up thereby causing the internal 
temperature sensor reading to rise up to 10 ˚C above ambient 
temperature. Once the charging process is complete, the 
logger will cool down and the internal temperature sensor 
readings will return to normal.  
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For loggers remaining connected to AC power, to prevent the 
logger from heating up again following the initial charge cycle, 
the logger will receive a one minute trickle charge each day 
rather than stay continually charged. This is sufficient to 
ensure the logger doesn’t self-discharge and will maintain the 
logger’s full charge status. 

Refer to section  4.9.3 for more details on the DataNet loggers’ 
power supply. 

3.5.2. Connecting DNL910 and 
DNL920 Loggers to the 
Network 

* Includes the PA models  

1. Turn on the logger by pressing the Scroll button . 
The unit will beep when turned on. As soon as the unit is 
turned on, the LCD screen will display the following 
message: 

 
2. The logger will then start scanning for networks. The LCD 

will indicate how many networks were found in range, and 
will announce when the scan is complete. Locked 
networks will not be listed. 

Scan for network Scan for network 
Found 2 networks

Scan complete  Scan for network Scan for network 
Found 2 networks

Scan complete  

 
To join the network created by your Receiver (there may be 
other networks created by your colleagues) scroll through the 

Fourier Systems 
Logger 
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found networks on the LCD (using the logger Scroll button) 

and press the Enter button  when you reach the required 
network. In the example below, the network required is the 
second network found. You can also rescan the networks by 
pressing Enter on the Rescan networks screen, which is 
reached by scrolling through all the found networks. 

Network 1:
ID: 014.061.082  

Network 2:
ID: 026.167.85  

Rescan networksNetwork 1:
ID: 014.061.082  

Network 2:
ID: 026.167.85  

Network 1:
ID: 014.061.082  

Network 2:
ID: 026.167.85  

Rescan networks

 
 

Note: If the logger did not detect a network, the unit will turn 
off in order to conserve the battery. 

 
3. Once you select the network, the logger will automatically 

join that network and a new message will be displayed on 
the LCD: 

 
Note: If the message Join failed appears on the LCD, then 
rescan for the network and try again. If the logger continually 
fails to join, then form a new network on the Receiver. 

4. The LCD will then indicate the following status message: 

 

Fourier Systems 
Ready 

Joined network: 
ID: 026.167.85   
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If the Receiver is disconnected for any reason, the following 
message is displayed: 

 

5. When the logger joins the network, the Logger icon  
will automatically appear in the Map View.  

a. The  symbol indicates the signal strength of the 
logger in the network.  

b. The  symbol indicates that the logger is running 

from internal battery supply. The  symbol indicates 
that the logger is running from external power supply. 

c. The  symbol indicates that the logger is a new 
addition to the network and has not yet been 
configured (setup). 

6. Repeat steps 1-3 for every logger in your system. 
7. In order to find the physical location of the logger you can 

right-click on the Logger icon in Map View and select Call 
Unit (Beep). The logger will then beep. 

3.5.3. Connecting Mini DataNet 
Loggers and Mini Repeater to 
the Network 

The Mini DataNet loggers (DNL804, DNL808, and DNL810) 
and Mini Repeater (DNR800) don’t have LCD screens 
therefore the process of joining these units to the network 
differs than that of the DataNet models with LCD.  

Fourier Systems 
No Receiver 
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Follow the steps below to connect these devices to the 
network. 
1. In the main menu, go to Network > Device Filter to first 

define the Mini DataNet devices that are allowed to 
connect to the network. Enter the SN of each Mini 
DataNet device in the text window and click Add. Click 
Remove to remove a SN of a device you don’t wish to 
join the network. 

 
Figure 9: Mini DataNet Device Filter dialog 

 
If a Mini DataNet device tries to join the network but it is 
not in the list then the software will send the Leave 
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Network command to the device as it tries to connect to 
the network. 
When a device tries to connect to a network and the 
software is down it will continue to the next available 
network. If the software is up either the software will 
accept it or it will send the Leave Network command. 

2. Ensure the network is not locked. Go to the Network 
menu and uncheck the Lock Network menu item. 

3. Take the first Mini DataNet device and from an Off state 
give the button on the front panel a short press. The 
green LED will blink once every second until the logger 
joins the network. The device icon will appear in the Map 
View. 

4. Repeat Steps 1 to 3 for all Mini DataNet devices you wish 
to join to the network. 

For more details on joining Mini DataNet units to the network, 
refer to section  4.13.  

3.5.4. Loading Map View Background 

Load an image into DataNet showing a map of your facility in 
order to place the Receiver and Logger icons in their relative 
positions. As you add more loggers to the system, this will 
prove very helpful.  
• Double click the Map View background to browse to the 

image directory and load the image. Remember to unlock 
the Map View in order to move the icons around. 

• Right-click the Map View background and two options will 
be available: Load Wallpaper and Reset Wallpaper, 
which resets to the default Fourier wallpaper. 
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Figure 10: Map View background image example 
 

Note: In Trial mode, loading a background image is disabled. 

3.6. Configuring the Logger 

Once you connected your DataNet loggers to the network, 
you must configure them in order to start acquiring data. 
5. Right-click on the Logger icon you wish to configure. 

Select Setup from the context menu. 
The Setup window will be launched. 
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Figure 11: Logger Setup window 

 
This dialog provides non-editable information such as the 
serial number, battery level, reception level and firmware 
version of the current unit.  
On the Device Setup and Alarm Setup tabs, the user is 
able to configure the following parameters:  



 
 

33 

 Unit's comment  
 Sampling rate  
 Transmission interval 
 Samples averaging  
 Temperature units °C/°F (on the logger LCD. Not 

applicable for Mini DataNet loggers) 
 Active sensors  
 Custom sensors' names  
 Alarm levels  
 Alarm duration  
 Alarm delay  
 Alarm pre delay 

6. Select the sensors you wish to connect to the logger for 
data acquisition. It doesn’t matter which order you select 
the sensors. You may only have Input 4 selected, for 
example, and Inputs 1 to 3 left unselected. 

7. Select the sampling rate and transmission interval (rate at 
which the data is transmitted from the logger to the 
Receiver). 

8. Unless you have Alarm levels you wish to edit (see the 
Alarms Setup tab), click either Setup and Run (to send 
the setup and immediately log data), or Setup Only (to 
send the setup but only log data at your command). 

9. If you selected Setup Only in step 4, right-click the 
Logger icon and select Run from the context menu to 
start logging data. 

10. To stop the logger, right-click the Logger icon and select 
Stop from the context menu. 

Note: Running the logger clears the logger memory. All 
previously recorded data will be erased when you begin a new 
logging session. 
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3.7. Viewing Data  

Once you run the logger, you have several ways of viewing 
the online data that is being acquired. 
• Online graph/table/statistics views 
• Logger icon tooltip 
• Sensor view 

3.7.1. Online Data Views 

Double clicking the Logger icon or selecting Display Data in 
the Logger icon context menu will open the online graph. 
This graph is updated in real-time with the newly recorded 
data. 
You can switch between Graph, Table and Statistics views to 
view the data in different formats.  

  
    
Figure 12: Online data – Graph view 
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Figure 13: Online data – Table view 
 

 
Figure 14: Online data – Statistics view  

3.7.2. Logger Tooltip 

Close the online data window and return to Map View. Scroll 
over the Logger icon and you will see a tooltip displaying the 
relevant logger information, including real-time data.  
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Figure 15: Logger tooltip 
This tool-tip is updated with every newly recorded sample. 

3.7.3. Sensor View 

Click the Sensor View icon  in the tool bar to switch to 
this view. Here, you can monitor the data by viewing data 
display of each individual sensor, rather than of each logger. 

 
Figure 16: Sensor view 
 
• If the sensor is in alarm, the sensor window will change 

color from green to red (just as the Logger icon would) 
• Double-clicking the individual sensor window will open the 

data in the online Graph view 
• Scrolling over the sensor window with the mouse cursor 

will display the logger tool tip with relevant logger data 
(similar to Map View)  
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Refer to section  5.4.2 for more details on using the Sensor 
View. 
 

Note: By going to Tools > Switch Sensor View Mode you 
can reduce the size of the sensor window to display only the 
sensor type and sensor data. Recommended for networks 
containing many loggers. 

3.8. Optimizing the Network 

This section outlines a number of features and suggestions for 
optimizing the DataNet network and getting the best 
performance out of the end units and parent units.  
For example, when you first setup your network, you want to 
ensure that the loggers are placed in the optimum position in 
order to receive and transmit data to/from the DataNet 
software. 
Refer to the DataNet specifications to guide you on the range 
of the DataNet units. With this knowledge, and based on the 
layout of your facility, you should have a good idea of the 
likely positional layout of your units. 

3.8.1. Signal Test Utility 

Rather than setup the system on a trial and error basis, 
DataNet has a Signal Test utility built in to the logger 
firmware, which gives you a clear idea of the strength of the 
signal of each logger to the Receiver, and the quality of the 
data link between Receiver and logger. 
 
Perform the following test on each logger in your system while 
deciding where to position the logger: 
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1. Using the Scroll button, scroll through the main menu on 
the logger until you reach the following display: 

 
 
2. Press the Menu button to run the test. 

The signal level and link quality will be displayed. As you 
move the logger further away from the Receiver, you will 
see these two parameters drop from a maximum of 100%.  
When the logger is out of range of the Receiver, you will 
see the following screen: 

 
3. To exit the Signal test, press the Scroll button. 

3.8.2. Overcoming RF Obstacles 

A universal issue concerning any wireless system is how to 
overcome a hostile RF environment. DataNet’s ZigBee RF 
protocol has been designed for these hostile RF environments 
that routinely exist onsite. ZigBee can overcome competing 
wireless noise and other problems communicating the data.  
Its mesh networking capabilities allows it to re-route signal 
traffic around temporary or permanent physical obstacles, 
radio-frequency interference, Repeater error or other such 
failures.  
The robustness of the system is such that there is no single 
point of failure, ensuring data recovery from end units on the 
network.  

Out of range 
 

Signal level: 
Run test -> Menu 
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Tips on overcoming RF barriers 
• When first creating the network in the environment where 

the loggers will be deployed, form a new network on the 
Receiver. There may be local interference on the 2.4 GHz 
free bandwidth. The ZigBee protocol, when forming a new 
network, selects the least noisy channel (out of 16 
available channels). Within this channel the units can 
change RF slots (by hopping) but cannot move to other 
channels while running. By running on a channel on a 
network created in another environment e.g. in the office, 
this channel may become noisy and therefore 
transmission range may be less than expected. 

• When placing units in an indoor or outdoor environment, 
bear in mind that walls, furniture, metal objects, etc. limit 
the RF coverage thereby reducing the range of the units.  

• Add Repeaters (DNR800 or DNR900) in range of end 
units and parent unit to enhance RF coverage and 
improve robustness of network. Have as many alternative 
transmission routes as possible in order to eliminate 
single points of failure.  

• When placing Repeater ensure it is not on the limit of its 
range to the end unit or parent unit (Repeater or 
Receiver), to avoid periods of unavailability due to 
changing RF conditions. 

• Add Short Range Repeaters (DNL910, DNL920 or PA 
models) to overcome RF interference nearby to the 
loggers. 

• The higher the Receiver is positioned the better reception 
quality it will obtain. 

3.8.3. Showing the Network Path 

By going to Network > Show Network Paths in the DataNet 
main menu, the software will show the actual path that the 
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system uses to communicate between Receiver and logger, 
for all units in the system. 

 
Figure 17: Showing network paths – Example 1 
You can also select Show Path from the logger context menu 
to display the individual path from the unit to the Receiver. 

Using this option you can see exactly how the system is built.  

 
Figure 18: Showing network paths – Example 2 
 
The screenshot above shows a system of three loggers (red 
squares) and two Repeaters (blue circles) transmitting to the 
Receiver. 
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The arrows show the path between the units. Note that they 
are bi-directional, meaning that the system is a two-way 
system with units both transmitting and receiving data. 
• A green path indicates a strong signal 
• A yellow path indicate a medium strength signal 
• A red path indicates a weak signal 

3.8.4. Adding Repeaters to the 
Network 

Loggers which aren’t in range of the Receiver can transmit to 
the Receiver via a Repeater/Short Range Repeater, which is 
in range. As DataNet is built using mesh networking 
technology Repeaters (DNR800 or DNR900) can be added to 
the system to enhance the network range.  
The DNR900 Receiver/Repeater is the same device, just 
configured differently from the main menu when turned on. 
Refer to section  4.14.3 to learn how to switch the DNR900 
unit type to Repeater. 
The DNR800 only functions as a Repeater. 

3.8.5. Short Range Repeater  

You may also enable a logger (DNL910, DNL920 or the PA 
models) to operate as a Repeater in addition to its logging 
capabilities. In this mode the logger is referred to as a Short 
Range Repeater (SRR).  
When in SRR mode the logger maintains the transmission 
range in accordance with its specifications. Therefore, the 
DNL910 and DNL920 will transmit at 4 dBm and the DNL910-
PA and DNL920-PA, with its built-in power amplification, will 
transmit at a greater range of 15 dBm.  
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To switch a logger to SRR mode, simply right-click the logger 
icon in the DataNet software Map View and select Enable 
Short Range Repeater Mode. 

Note: In SRR mode the logger must be connected to AC 
power at all times as the power consumption is much greater. 

3.9. Recommended Approach to 
Deploying DataNet Units 

Now that you have a general understanding of how the 
DataNet system functions, you may wish to use Fourier’s 
recommended approach for initial deployment of the system. 
This approach will ensure a smooth and efficient deployment 
of your DataNet units and you may then tweak this approach 
based on experience you gain while using the system.  

Note: When deploying the system bear in mind that several 
factors could cause interference with the system, such as 
electromagnetic pulses, metal shielding in the vicinity of the 
transmissions, other devices using the same 2.4 GHz band, 
etc. Be familiar with your environment before deploying the 
system. Also refer to section  3.8. 

 
1. After you have charged the DataNet units and are ready 

to deploy them in your facility, collect all units - data 
logger end units, Receiver and Repeaters (if relevant) – 
and bring them to your PC workstation.  

2. Connect the Receiver to the PC and form a network. Turn 
on the units and one by one bring them online so you can 
view their icons in the DataNet software’s Map View. 

3. Configure each of the units via the Setup feature. At this 
stage it is not necessary to configure the type of sensors 
you will be using, or sample rate, alarm levels, etc. The 
point of this step is to configure each of the units with a 
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logger or Repeater name that indicates where in your 
facility they will be deployed. For example, Room 15 
Freezer or Floor 2 Bio Lab. This will make it much easier 
for you to recognize the units in the Map View once you 
have deployed them. Once in place, you can reconfigure 
the units however you like.  

4. It is also recommended, if possible, to change the Map 
View default background to a diagram or map of your 
facility. You can then move the logger or Repeater icons 
accordingly so you can have a visual representation of 
their location in the facility. 

5. Take each logger and begin to distribute in your facility in 
the precise location you would like them to be based. 
Once in position you can then run the Signal Test on each 
logger to verify that you have a good signal to the 
Receiver. If you are out of range and there is no 
alternative location for the logger, you will most likely have 
to add at least one Repeater to the network, or replace 
the existing logger with a PA logger for longer 
transmission range.  

6. Once each of the loggers is in position return to the PC 
and in Map View, verify that each of the loggers is online. 
You can also use the Show Network Paths feature to 
see the path of the logger to the Receiver, and the 
strength of the transmission.  

7. If you determine that you need to add Repeater/s to the 
network in order to bring end units online or enhance the 
transmission where the signal is weak, then deploy the 
Repeater/s with the following points in mind: 
a. There must be an electrical socket accessible at the 

location of the Repeater as they must be powered 
externally in order to run for more than a few hours. 

b. Place the Repeater/s as high from the ground as 
possible in order to enhance the wireless signal from 
its antenna.  
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c. Expose the Repeater/s to as many end units as 
possible. For example, if there is a room with several 
offline end units requiring a Repeater, position the 
Repeater next to the room so that it is in range of as 
many of these end units as possible, so you don’t 
have to add more Repeaters.  

8. After you have deployed the Repeater/s return to the 
software and using the Show Network Paths feature verify 
that all end units are now successfully transmitting to the 
Receiver, either on their own or via a parent Repeater. 
You can continue to tweak the position of the units until 
you are satisfied with the quality of the transmission. 

9. Now that the units are in place the last step of initial 
deployment is to reconfigure each unit to start data 
acquisition. Configure the sensor setup, sample rate, 
transmission rate, alarm levels, Email/SMS notifications, 
etc. as you see fit.  
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Chapter 4:  
DataNet Hardware 
Overview 

This chapter details the hardware features of the DataNet 
system components: the data loggers and the 
Receiver/Repeater. 

4.1. Data Logger Front Panel 
Layout 

4.1.1. DNL910 and DNL920  

Apart from the color scheme, the DNL910, DNL920 and PA 
data logger models have the same front panel design. 

Scroll button
Menu/Enter button

LCD screen

Scroll button
Menu/Enter button

LCD screen

 
Figure 19:  DNL910 data logger front panel 
LCD screen 
Displays logger status, logger data, Min/Max values and network 
information. 
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Menu/Enter button 
Use to enter logger menu options and to execute logger 
commands. 
Scroll button 
Use to scroll though menu items and to power on unit. 

4.1.2. DNL804, DNL808 and DNL810 

The Mini DataNet logger models have the same front panel 
design. 

Multi-function 
button

Dual-color 
LED indicator

Multi-function 
button
Multi-function 
button

Dual-color 
LED indicator

 
Figure 20:  DNL808 data logger front panel 
Multi-function button: Use to execute logger commands. 
Dual–color LED indicator: Indicates status of logger such as 
joining network, leaving network, etc. 
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4.2. Data Logger External 
Connections 

4.2.1. DNL910 and DNL920 

External connections of the DNL910, DNL920 and PA models 
are exactly the same. 

 

Mini USB port

12 V power socket 
Negative Center

Four sensor 
inputs

Excitation

Mini USB port

12 V power socket 
Negative Center

Four sensor 
inputs

Excitation

 
Figure 21:  DNL920 data logger external connections 
 
Mini USB Port 
To enable data download direct to PC via USB port. 
12 V Power Socket 
To connect logger to external power supply (negative center). 
Sensor Inputs 
Pluggable screw terminal blocks marked In-1 to In-4 (from left to 
right), to connect wide range of sensor types for data acquisition. 
All four inputs can be used simultaneously. Sensors can be 
connected in any order. 
To connect a sensor to the DataNet data logger, unplug the 
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screw terminal, connect the sensor’s wires to the terminals, and 
then plug the terminal back to the corresponding socket on the 
input block. 
Excitation socket 
Output power socket used to power external sensors, power 
derived directly from the external power supply adaptor.   

4.2.2. DNL804 

External 
antenna

External Current 
4 to 20 mA input

External 
antenna

External Current 
4 to 20 mA input

 
Figure 22:  DNL804 data logger external connections 
 
External antenna: For extended transmission distance of the 
logger. 
External 4 to 20 mA input: Standard input for connecting to 
sensor with 4 to 20 mA output. 
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4.2.3. DNL808 

External 
antenna

External NTC 10 
KΩ input

External NTC 10 
KΩ probe

External 
antenna

External NTC 10 
KΩ input

External NTC 10 
KΩ probe

 
Figure 23:  DNL808 data logger external connections 
 
External antenna: For extended transmission distance of the 
logger. 
External NTC 10KΩ input: Standard input for connecting to 
NTC probe. 
External NTC 10KΩ probe: Fourier-supplied NTC probe 
(part of DNL808 kit). 
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4.2.4. DNL810  

The DNL810 doesn’t have any external connections. It has 
two internal sensors only, temperature and humidity. 

4.3. DNR800 Mini Repeater 
Front Panel Layout 

Multi-function 
button

Dual-color 
LED indicator

Multi-function 
button

Dual-color 
LED indicator

 
Figure 24:  DNR800 Mini Repeater front panel 
Multi-function button: Use to execute logger commands. 
Dual–color LED indicator: Indicates status of Repeater such 
as joining network, leaving network, etc. 
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4.4. DNR900 
Receiver/Repeater Front 
Panel Layout 

Scroll button
Menu/Enter button

LCD screen

 
Figure 25:  Receiver/Repeater front panel 
LCD screen 
Displays Receiver/Repeater status and network information. 
Menu/Enter button 
Use to enter logger menu options and to execute logger commands. 
Scroll button 
Use to scroll though menu items and to power on unit. 
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4.5. DNR800 Mini Repeater 
External Connections 

 
Figure 26:  Mini Repeater external connections 
12 V Power Socket 
To connect unit to external power supply. Plug in an AC/DC 9-12 V 
adaptor to power the unit. There is no battery supply so when 
disconnected from the adapter the unit will shutdown. The adaptor 
should meet the required specifications. Refer to  Appendix A: 
DataNet Specifications. 
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4.6. DNR900 
Receiver/Repeater 
External Connections 

12 V power socket
Negative Center

External Alarm

Mini USB port

 
Figure 27:  Receiver/Repeater external connections 
Mini USB Port 
To connect Receiver to PC and be detected by DataNet software. 
Connect the mini USB Type B plug (rectangle plug) of the supplied 
USB communication cable to the Receiver and the USB Type A 
plug (flat plug) to the computer. 
Refer to section  4.10.  
12 V Power Socket 
To connect unit to external power supply. Plug in an AC/DC 9-12 V 
adaptor to power the unit. To use as a Receiver or Repeater and 
maintain network integrity, the unit should be powered at all times. 
Connecting external power to the unit automatically charges the 
internal back-up battery. The adaptor should meet the required 
specifications. Refer to  Appendix A: DataNet Specifications. 
External Alarm 
Connect external alarm e.g. siren, audible alarm, to this input. 
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Whenever a logger on the network is in alarm status, the external 
alarm will be activated. Refer to section  4.7.6 for more details. 

4.7. Data Logger Sensor 
Overview 

This section provides an overview of the hardware 
specifications of the DataNet data loggers.  

4.7.1. Internal Sensor Types 

The DNL810, DNL910, DNL920, DNL910-PA and DNL920-PA 
loggers include internal sensors, depending on the logger 
model. 

Sensor Measurement 
Range 

Accuracy Logger 
Model 

Digital Humidity  5% to 95% ±3% (in DataNet 
software) 
±4% (on logger LCD) 

DNL920 
DNL920-PA 
DNL810 

±0.5 ºC DNL920 
DNL920-PA 

Digital Temperature -20 ºC to 50 ºC 

±0.4 ºC DNL810 
Temperature 
PT100  

-20 ºC to 50 ºC ±0.3 ºC  DNL910 
DNL910-PA 
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4.7.2. External Sensor Types 

DNL910, DNL920 and PA Models 
Each of the four input channels of these data logger models 
are multi-purpose and can be individually configured to any of 
the following types and ranges.  

Sensor Measurement 
Range 

Accuracy Available 
Inputs 

Current  4 to 20 mA ± 0.5 % In-1 to In-4 
Contact Open (0) /  

Close (1) 
N/A In-1 to In-4 

Frequency 20 Hz to 4 KHz N/A In-4 only 
Pulse Counter 1 to 65,536 pulses 

0 to 4 KHz 
N/A In-4 only 

Temperature 
PT100 (2-wire) 

-200 to 400 ºC -200 to -60 ºC ±0.5 % 
60 to 400 ºC ±0.5 % 
-60 to 60 ºC ±0.3 ˚C 

In-1 to In-4 

Temperature TC-J -200 ºC to 1,000 ºC -200 to -60 ºC ±0.5 % 
60 to 1,000 ºC ±0.5 % 
-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Temperature TC-K -200 ºC to 1,000 ºC -200 to -60 ºC ±0.5 % 
60 to 1,000 ºC ±0.5 % 
-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Temperature TC-T -200 ºC to 400 ºC -200 to -60 ºC ±0.5 % 
60 to 400 ºC ±0.5 % 
-60 to 60 ºC ±0.5 ˚C 

In-1 to In-4 

Voltage 0 to 1 V ± 0.5 % In-1 to In-4 
Voltage 0 to 50 mV ± 0.5 % In-1 to In-4 
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DNL804 
Sensor Measurement 

Range 
Accuracy 

Current  4 to 20 mA 0.5 % 

 

DNL808 
Sensor Measurement 

Range 
Accuracy 

Temperature NTC 
10 KΩ -50 to 150 ºC 

-50 to 60 ˚C: ±0.3 ˚C 
60 to 150 ˚C: ±0.5 % 

4.7.3. Sensor Connection 

Connect the sensor/s to the terminal block/s at the top of data 
logger: 

 
Figure 28: DataNet logger sensor inputs 
 
Sensors do not have to be added successively. You may only 
configure In-4, or configure In-1 and In-3, for example, when 
setting up the logger via the software. 
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4.7.4. External PT-100 and NTC 
Sensor Connection 

The PT-100 (for the DNL910, DNL920 and PA models) and 
NTC (for DNL808) sensors, as supplied by Fourier Systems 
comes pre-wired to the data logger’s terminal block.  
The PT-100 positive polarity (red) and ground (white) wires 
are connected to the + input of the terminal block. The 
negative polarity (black) wire is connected to the – input on 
the terminal block.  

4.7.5. Programming Limitations for 
DNL910 and DNL920 

The standard sampling rate for all sensors on all inputs is from 
a maximum of one sample every second to a minimum of one 
sample every two hours. However, there are certain 
limitations using a specific combination of sensors, which 
must be taken into account when programming the DataNet 
data loggers.  

Note: The software integrates all programming limitations 
automatically when configuring the loggers.  

Please refer to the table below for DataNet programming 
limitations, where: 
PT100, Thermocouple J, K or T  = A 

Internal Digital Temperature (on DNL920) = B 
 

Sensor 
Combination 

Maximum 
Sampling Rate 

Example Setup 

3 x A 
4 x A 

One sample every 
three seconds 

In-1: PT-100 
In-2: TC-J 
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Sensor 
Combination 

Maximum 
Sampling Rate 

Example Setup 

A + B In-3: TC-J 
(2 x A) + B 
(3 x A) + B 

One sample every 
four seconds 

Internal: Temp 
In-1: TC-T 
In-2: PT-100 

(4 x A) + B One sample every 
five seconds 

Internal: Temp 
In-1: TC-T 
In-2: TC-J 
In-3: PT-100 
In-4: PT-100 

Table 1: Data Logger programming limitations 

4.7.6. External Alarm Output 

The DataNet system supports connection of an external alarm 
e.g. siren, audible alarm, to the Receiver external alarm input 
or to In-1 of the DNL910, DNL920 and PA model data loggers.  
When connected to the Receiver, the external alarm will be 
activated whenever a logger on the network is in alarm status. 
When connected to the data logger, the external alarm will be 
activated only when that specific logger is in alarm status. 
Once there is no alarm status, the external alarm will be 
deactivated. 
 

Data Logger External Alarm 
In-1 of the DNL910, DNL920 and PA models serves either as 
a standard sensor input or as an external alarm output. 
Configure In-1 as Alarm Normally Open or Alarm Normally 
Closed in the logger Setup window in the DataNet software. 



 
 

59 

Normally Open will result in the alarm being activated during 
alarm status (the circuit will be closed).  
Normally Closed will result in the alarm being activated when 
logger is not in alarm and therefore deactivated when there is 
an alarm (the circuit will be opened). 

Connect In-1 to your external alarm device.  
Use the Alarm Setup tab in the Setup dialog to define the 
logger alarm settings. If these settings are breached then the 
alarm will be activated. 
 

Receiver External Alarm 
By connecting the external alarm to the Ext Alarm input on 
the Receiver, any alarm on the entire network will activate the 
external alarm. 
Use the Alarm Setup tab in the Setup dialog to define the 
logger alarm settings. Whenever the Receiver receives an 
alarm status from any logger on the network, the external 
alarm will be activated. No additional configuration in the 
software is required. 
 

External Alarm Schematic 
See the schematic below explaining how to hook up an 
external alarm to the DataNet unit. 
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- +

Relay

- +

- +
Alarm device 

(e.g. siren)

+
-

3-4 V battery 
to power relay

- +

Relay

- +

- +
Alarm device 

(e.g. siren)

+
-

3-4 V battery 
to power relay

 
Figure 29: External alarm schematic 
 
• + from DNR900 goes to – of the Relay inputs 
• + of Relay input goes to battery that powers the Relay 
• Load inputs of the Relay go to the Alarm device e.g. siren, 

lights, etc. 
• - of the battery goes to – of DNR900. 

Note: Maximum load of the Relay is 50 mA, 3 V. 
Refer to  Appendix A: DataNet Specifications for the full 
external alarm output specification. 
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4.7.7. Polarity 

Current, voltage, thermocouples and user defined sensors 
have distinct polarity. Be careful to connect them in the right 
polarity. 

4.7.8. Frequency/Pulse Counter 

Connect the signal wires to In-4 terminal blocks, and select 
Frequency or Pulse counter for Input 4 from the logger 
Setup window in the DataNet software. Inputs 1 to 3 are still 
available for other sensors. 
 
The Frequency/Pulse counter is optically isolated from the 
internal circuitry and can simultaneously measure a signal 
source, together with another input. 

4.7.9. User Defined Sensors 

DataNet provides a simple and straightforward tool for 
defining a limited number of custom sensors. Almost any 
sensor or transducer with 0 – 1 V or 4 – 20 mA output is 
accepted by the DataNet logger and its electrical units are 
automatically scaled to meaningful user-defined engineering 
units. 
The sensor definitions are stored in the logger’s memory and 
are added to the sensors list. The sensor’s readings are 
displayed in the user defined units only in the DataNet 
software. Future versions will also support displaying the user 
defined engineering units on the logger LCD. 
Refer to section  5.8.1 for more details.  
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4.7.10. Sensor Alarms 

Via the software, users can define minimum and maximum 
alarm levels for each input individually. Users can define pre-
low and pre-high alarm levels, for an additional level of safety 
in case the logger is approaching an actual breach of alarm. 
The DataNet logger display indicates when the sensor reading 
is in alarm of any type. The symbols AL-H, AL-L, AL-P-H or 
AL-P-L are visible next to the corresponding input readings.  
Refer to section  5.16 for more details. 

4.7.11. Sensor Calibration 

The DataNet data logger is shipped fully calibrated. However, 
further calibration can be applied via the DataNet software. 
The calibration parameters are sent to the data loggers 
wirelessly and stored in the logger’s memory.  
Users may calibrate individual input as well as all inputs at 
once. Calibration settings may be saved and then loaded into 
the logger at a later date if the calibration settings have 
changed. 
Refer to section  5.17.4 for more details. 

4.8. Unit Serial Number and 
Comment 

Every DataNet data logger and Receiver/Repeater unit is 
embedded with a unique serial number.  
The data logger only can be loaded with a descriptive 
comment to identify its task and location. You may add or edit 
the comment of any logger on the network via the DataNet 
software.  
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Every time data is transferred to the computer it is labeled 
both with the logger’s serial number and comment and is 
displayed in the graph or data table view. 
The unit serial number is also marked on a sticker on the back 
of the product.  

4.9. Power Supply 

4.9.1. DNR900 in Receiver Mode 

The Receiver unit is powered via the USB port of the PC, 
when connected via the mini USB cable. In addition, the unit 
can run for a limited time (up to three hours) from an internal 
NiMh rechargeable battery. To charge the internal battery, 
connect the unit to the AC power supply supplied with the 
DNR900. The internal battery pack is generally used as a 
back up power supply in the event the external power supply 
fails.  

Note: When in Receiver mode, the unit must be connected to 
external power at all times. While running on internal power, 
the unit will run for only several hours before shutting down 
and therefore shutting down the DataNet network which the 
Receiver is managing. 

4.9.2. DNR800 and DNR900 in 
Repeater Mode 

The DNR800 must be connected to external AC power at all 
times. This device does not have an internal battery so when 
the external power supply is disconnected the unit will 
shutdown.  
When in Repeater mode, the DNR900 must be connected to 
external AC power at all times using the supplied AC charger. 
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Otherwise, when the internal backup batteries drains and 
shuts down the unit, all the end units dependent on the 
Repeater to transmit to the Receiver, will not be detected by 
the software. The user won’t be able to monitor data readings 
from these units until the Repeater comes back online. 
When connected to external power supply, the Repeater 
battery will not be charged when the unit is turned off. This will 
allow the system to protect the battery from overheating. 

4.9.3. DNL910 and DNL920 Data 
Loggers 

The DNL910, DNL920 and PA data loggers run from an 
internal NiMh rechargeable battery as well as from external 
AC power supply.  

Note: The PA (power amplifier) models must be connected to 
AC power at all times due to the high power consumption of 
these units.  

Depending on the logger configuration, from a fully charged 
battery, the non-PA data logger can run for up to several 
months. Refer to section  4.9.6 for more details on battery life. 

Note: Charge the data logger units for 16 hours before using 
them for the first time. 

When connected to external power supply, the data logger 
battery will not be charged when the unit is turned off. This will 
allow the system to protect the battery from overheating. 
 

First Time Charging 
From a fully drained battery, you must charge the battery for 
16 hours to bring it to a full charge. Once the charge cycle is 
complete, the logger will run from the external power supply, 
without draining (or charging) the internal battery. In order to 
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maintain a fully charged battery and ensure the battery 
doesn’t self-discharge, the battery charger will daily charge 
the unit for a minute to maintain the battery capacity. 

Note: Before storing the DataNet units make sure you have 
unplugged all the sensors and turned the units off via the 
keypad.  

 

Standard Charging 
When a logger is reconnected to the AC charger it will begin 
the 16-hour charge cycle, no matter what the status of the 
battery. Once the charging cycle is complete the logger will 
run from external power supply. 
The one exception to this scenario is if the charger is 
reconnected within an hour of disconnection and the battery 
level is at least 90%. In this situation the charging process will 
not restart. 
 

Effect of Charging Battery on Temperature 
Sensor 
For loggers measuring data with the internal temperature 
sensor, it is critical to note that during the charge cycle the 
logger will heat up thereby causing the internal temperature 
sensor reading to rise by up to 10 ˚C above ambient 
temperature. Once the charging process is complete, the 
logger will cool down and the internal temperature sensor 
readings will return to normal.  
For loggers remaining connected to AC power, to prevent the 
logger from heating up again following the initial charge cycle, 
the logger will receive a one minute trickle charge each day 
rather than stay continually charged. This is sufficient to 
ensure the logger doesn’t self-discharge and will maintain the 
logger’s full charge status. 
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4.9.4. DNL804, DNL808 and DNL810 
Data Loggers 

The Mini DataNet loggers are powered by non-rechargeable 
internal 2/3 AA lithium batteries. There is no external power 
supply for these loggers. 
Depending on the logger configuration, the battery can last up 
to 10 months before they need to be replaced. 
 

Replacing the Mini DataNet Battery 
To replace the batteries on the Mini DataNet loggers, follow 
these instructions: 
1. Stop the unit from the DataNet software. 
2. Turn off the unit using the logger button.  
3. Remove the two screws located on the top panel of the 

logger (where the antenna is connected) and with care 
pull out the internal compartment containing the logger 
circuit board and battery.  

4. Remove and replace the battery, ensuring the correct 
polarity of the battery. 

5. Push the internal compartment back into place.  
6. Secure the panel with the two screws.  

Note: With the DNL808 also disconnect the external sensor to 
avoid damaging it. 

4.9.5. Power Adapter 

The DataNet power adapter is used to power the DNR900, 
DNL910, DNL920 and PA model units. The mains adaptor 
(AC/DC adaptor) converts mains power (from a wall outlet) to 
a voltage suitable to the DataNet hardware unit. 
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• Output: Capacitor filtered 9 to 12 VDC, 300 mA  
• Female plug, center negative 

 
Note: Only use Fourier-supplied power adapters to avoid 
damaging the units with incorrect power supply. 

4.9.6. Data Logger Battery Life 

Battery life depends on the logger sampling rate, transmission 
rate, type of sensor, network architecture and number of 
measured sensors.  
• DNL910 and DNL920 can last up to six months on a 

charged battery. 
• DNL804, DNL808 and DNL810 can last up to 10 months 

on a new battery.  
The table below provides some example scenarios of 
standard logger configurations and expected battery life. 
Logger 
Model 

Sensor Setup Sample 
Rate 

Transmission 
Rate 

Battery 
Life 

DNL910 • Internal 
Temperature 

• 4 x Thermocouple 

15 
minutes 

15 minutes Five 
months 

DNL910 1 x PT-100 15 
minutes 

15 minutes Six 
months 

DNL808 1 x NTC 10 KΩ 15 
minutes 

15 minutes 10 
months 
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Logger 
Model 

Sensor Setup Sample 
Rate 

Transmission 
Rate 

Battery 
Life 

DNL810 • Internal 
Temperature 

• Internal Humidity 

15 
minutes 

15 minutes 10 
months 

Table 2: Data logger battery life scenarios 

4.10. USB Communication Cable 

A mini USB communication cable is supplied as part of the 
DataNet PC Suite. This cable has the following roles: 
• To connect the Receiver to the DataNet PC workstation, 

allowing the Receiver to communicate with the DataNet 
software and manage the DataNet network.  

• To power the Receiver when connected to the PC (the 
internal battery is not charged). 

• To enable data download directly via USB for DNL910, 
DNL920 and PA model loggers. 

• To enable firmware update directly via USB for DNL910, 
DNL920 and PA model loggers as well as DNR900. 

• To enable shutdown directly via USB of DNL910, DNL920 
and PA model loggers. 

Note: The USB driver is installed as part of the software 
installation process. Without this driver the PC won’t detect 
the Receiver. To avoid compatibility problems do not connect 
the Receiver to the PC before installing the USB driver. 
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Figure 30: USB communication cable 

4.11. DataNet Keypad Overview 

Note: Explanations for DNL units also apply to the PA models 

4.11.1. DNL910, DNL920 and DNR900 
Keypad 

The DNL910, DNL920 and DNR900 units each have two 
buttons on the keypad, used to navigate through the LCD 
menu options, as well as turn on the units. 
Refer to section  4.12 to learn how to operate the data loggers 
and sections  4.13 and  4.15 to learn how to operate the 
Receiver and Repeater. 

Type A plug 
Connect to device USB port 

Type B plug  
Connect to PC USB port 
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The Menu button  has two 
functionalities: 
Navigate to the main menu. When 
pressed from within a submenu, the 
display will take you back to the main 
menu.  
Selecting an option from one of the 
menus. When pressed on one of the 
main menu items, it will take you to 
the sub menu options. 

The Scroll button  has two 
functionalities: 
• When the unit is off, pressing this 

button will power the unit on.  
• Scrolls through the menu options. 

4.11.2. DNL804, DNL808, 
DNL810 and 
DNR800 Keypad 

The Mini DataNet units have one button 
on the keypad. This button is multi-
functional and is used to perform 
various functions such as: 
• Turning on/off the unit 
• Starting signal test 
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• Leaving the network 
• Locating device icon in software Map View 
 
Refer to section  4.13 to learn how to operate the Mini DataNet 
and Mini Repeater devices. 
. 

4.12. Operating the DNL910 and 
DNL920  

This section explains how to operate the DNL910, DNL920 
and PA model loggers and provides an overview of the menu 
options on the units’ LCD screen. 

4.12.1. Turning on the Unit 

In order to view the logger menu options, the unit must be 

powered on by pressing the Scroll button  on the keypad. 
Ensure the logger is charged or connected to the AC adapter. 
Once the unit is switched on it will emit a short beep and the 
screen will read Search Parent until the Parent unit e.g. 
Receiver, is detected. A welcome message is the displayed:  

 

4.12.2. Display Shutdown 

When the data logger is running from batteries only, if the 
screen is inactive for thirty seconds it will turn off. However the 

Fourier Systems 
Ready 
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logger will continue to operate in the background. Press the 
Scroll button to enable the LCD screen again. The screen will 
not turn off during firmware upgrade. 
When connected to external power supply the logger screen 
will always stay on. 

4.12.3. Joining a Network 

When a logger is powered on or reset, it will automatically 
scan for a network after the welcome message has appeared.  
There are four scenarios that can occur while scanning for a 
network: 
Scenario 1: The unit can’t find the last network that it was 
connected to. For example, the logger is a new unit which was 
never previously joined a network. 
Scenario 2: The unit scans and finds the last network it was 
connected to, and joins that network. 
Scenario 3: The unit can’t find any networks at all. 
Scenario 4: The unit found a network but failed to join. 
 
Read below for more details on each scenario. 

Scenario 1 
If the unit can’t find the last network that it was connected to 
(for example, it’s a new unit), the unit will display all the 
networks that are in range: 

 
Where # is the number of networks found 
 

Scan for network 
 

Scan for network  
Found # network 
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Once the scan has been completed the following screen 
appears: 

 

If more than one network was found, the user will need to 
select the network ID that he wants to connect to. The user 
uses the Scroll button to scroll through the Network IDs. The 
relevant network is selected using the Enter button.  

Network 1:
ID: 014.061.082  

Network 2:
ID: 021.207.175  

Network 1:
ID: 014.061.082  

Network 2:
ID: 021.207.175  

Rescan networks

 

Once the network has been selected the following screen will 
be displayed. 

 
 
To rescan the networks, simply select the Rescan Networks 
option and the logger will start the scanning process again. 
 
If only one network was found the system will automatically 
connect to that network without the user needing to select the 
network manually. 

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

 

Scan complete   
 

Joined network: 
ID: 021.207.175   
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The logger display will return to the welcome message, which 
consists of the logger name (editable via the software) and the 
network status: 
• Ready - If connection to the DataNet software is 

established. 
• Software is down - If established connection to the 

Receiver but the DataNet software is down (PC is off, 
software is not open, etc.) 

• No Parent Signal – The parent unit, either the Receiver 
or Repeater, is not detected by the logger therefore the 
logger is not transmitting its data to the network.  

 

Fourier Systems
Ready

Fourier Systems
Software is down

Fourier Systems
No Parent Signal

Fourier Systems
Ready

Fourier Systems
Software is down

Fourier Systems
No Parent Signal

 

The logger will continue to search for the parent unit (at 
specific intervals) and the screen will continue to read 
Search Parent until the parent is found. 

Scenario 2 
When the unit scans for networks and finds the last network 
that it was connected to it will automatically connect to the last 
known network. 

 

As in Scenario 1, the logger display will then return to the 
welcome message displaying the unit name and status.  

Joined Network: 
ID: 021.207.175   
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Scenario 3 
The system can’t find any networks at all. 
If no networks were found, the unit will display the following 
screens. 

Scan for network 
Found 0 network

Scan complete  No found networks:
Rescan networks 

 
Scenario 4 
The unit found a network but failed to join. 
The unit will perform up to 99 retries to join the network before 
scanning for networks again. Press any of the unit buttons to 
cease the attempts to join the network. 
A unit may fail to join a network if it is far from the Receiver, 
requiring several hops to reach the Receiver, or the network 
itself is large with many units. The attempt to join a network is 
made in under a second in real-time and on high traffic 
network, it may result in failure to join.  
Moving the unit closer to the Receiver can help the logger to 
join successfully. If the logger still can’t join, form a new 
network or contact Fourier technical support. 

4.12.4. Main Menu Options 

There are three menu categories on the data logger: 
• View Data  
• Status 
• Min/Max Values 

Note: If the unit is not in Run mode only the Status menu 
options will be available. 
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Press the Menu button to reach the main menu display. Scroll 
through the main menu options (View Data, Status and 
Min/Max Values) using the Scroll button. Once you reach the 
main menu option you need, press Enter to select that option 
and enter the sub menus. 
 

View Data Menu  

 
 

Note: View Data is the default page when the unit is running.  

If there is more than one sensor running, the screen will auto 
scroll between the sensors showing the sensor name and 
senor value. These are real-time displays. 
The display will switch back to the View Data screen after five 
minutes if none of logger buttons have been pressed.  
If the sensor breached any of the predefined alarm levels, 
then the alarm symbol will be displayed alongside the data 
reading.  
For example: 

 
The logger display alarm symbols are: 
• AL-HI : Alarm High 
• AL-Lo : Alarm Low 
• AL-P-H : Pre Alarm High 
• AL-P-L : Pre Alarm Low 

In-TMP 
24˚C         AL-Lo 

        
         View Data   
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` 

Status Menu 

 
The Status menu contains the following sub menus, all 
reachable by using the Scroll button.  
The sub menus are outlined below in the order in which they 
appear on the logger display. 
 
Name and Status 
As explained previously, the unit name (or Comment) is 
displayed on the first row and the second row indicates the 
logger status.  
If the logger is running, then the following screen is displayed. 

 
 
Mark Unit on PC 
To indicate the logger icon in the software’s Map View, press 
the Enter button when this screen is displayed. The logger’s 
icon located in the Map View will blink a number of times. 
Batt Level (battery level) 
If the power adapter is not connected the battery percentage 
will be displayed. 
If the power adapter is connected Battery charging will be 
displayed.  

Fourier Systems 
Logger running  

        
          Status  
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Signal Level Test   
The Signal Level test allows the user to check the signal 
strength and quality of the link between the logger and its 
parent unit. This test is used to determine optimal positioning 
of the logger during deployment.  

 
 
By pressing the Menu button the unit will show the signal level 
and link quality in percentage terms. 
If there is no connection with a parent unit, an Out of range 
message will be displayed. 

 

• Signal level: Indicates the reception level between end 
unit and parent unit. If the level falls below 20% then the 
logger should be placed in a better location or a Repeater 
should be added. 

• Link quality: Calculation of the data transmitted with no 
errors from the logger to the parent unit. If the level falls 
between 85% then the logger should be placed in a better 
location or a Repeater should be added. The lower the 
link quality %, the more retries are needed in order for the 
logger to send all of its data. 

Out of range Signal level:   80 
Link quality:   95 

Batt Level:      
Battery charging 

Batt Level:     67% 

Signal level: 
Run test -> Menu 
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Note: The signal level may be low but the link quality can still 
be 100%. 

 
You will not be able to run the Signal Level test when the 
logger has lost its connection to the network. If you tried, then 
the following screens are displayed: 

 
 
Firmware Version  
This menu informs the user of the logger firmware version. 
This is helpful when you need to upgrade the system 
firmware, to check the current version. Or when contacting 
Fourier technical support, with any technical issues. 

 
The firmware version is commonly referred to by the numbers 
in bold in the screen above. For example, the firmware 
version which is supported by this user guide is v2.30.  
S/N 
This menu displays the unit’s eight digit SN. 

 
 

No Parent signal Fourier Systems  
No Parent found  

S/N 12345678 

Firmware version: 
2.03.04.02.30.00 
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Network Data 
This menu displays the unique network ID to which the unit is 
currently connected. This ID will match the network ID 
displayed in the software in the Receiver icon’s tooltip in the 
Map View. 

 
Device Mode 
There are two possible device modes: 
• Logger 

Device is operating as standard data logger 
• Logger – Repeater 

Device is operating as a Short Range Repeater. Refer to 
section  3.8.5 for more details. 

 
Leave Network  
If this option is selected, the unit will first leave the network 
and then reset itself. The scan network procedure described 
in section  4.12.3 will begin. The only exception to this 
procedure is that even if the last connected network is found 
during the scan, the unit will not automatically connect to it.  

 

Leave network 

Network data: 
ID: 014.061.082 
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Note: If the logger was in Run mode prior to sending the 
Leave Network command the software will download all data 
from the unit first and then force it to leave the network.  

 
Reset Unit  
When the unit is reset, upon start up it will automatically scan 
for networks. The unit will automatically connect to the 
previously connected network assuming it was found in the 
network scan. 
Following reset the unit will continue to operate according to 
its last set up instruction. For example, if the logger was in 
Run mode, then after reset it will continue to run and record 
data. 
 
Turn Off Unit 
Selecting this option will shut the unit down. You can turn the 
unit on again by pressing the Scroll button.  
It is recommended to turn off the unit when it is not in use. 

 
Note: Turning off the logger when in Short Range Repeater 
mode can have adverse affects on your network, as other 
units may be dependent on the Repeater for transmitting its 
data to the Receiver. To prevent the SRR from being a point 
of failure if shut off, ensure the network is robust enough by 
having alternative routes for the end units to reach the 
Receiver.  

Min/Max Values Menu  
Each sensor’s minimum/maximum readings (taken from the 
current logging session) will be displayed on two rows.  

Turn off unit 
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The first row indicates the sensor type, along with the 
measurement units e.g. V, and the alarm indication if there is 
an active alarm on this sensor. 
The second row indicates the minimum and maximum 
measured value and the units. H and L represent High and 
Low values, respectively. 

 

4.12.5.  Additional Logger Screens 

Unit Beep 
When the DataNet software activates the Call Unit feature, the 
logger will beep and the following screen will be displayed:  

 
Refer to section  5.14.5 for more details. 
 
No Parent Signal 
When a logger’s parent unit, such as a Repeater or Receiver, 
goes offline then the following screen is immediately displayed 
on the logger: 

 
For example, this could happen if the Receiver managing the 
network has formed a new network, so there is no Receiver 
managing the previous network. Or if the parent unit is a 

          Unit Beep 
Fourier Systems 

No Parent signal 

In-TMP ˚C 
26.06H     25.61L 
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Repeater, and it goes offline, then the logger will display this 
message.  
Once it has determined that the parent signal is lost, it will try 
to establish a connection with the network via another 
Repeater but if it fails then the following screen is displayed: 

 
 
You will have to leave the network and rescan for a new 
network. 
 
Loading Firmware  
When updating the firmware of the data logger via the 
software’s Firmware Update Center, the logger screen will 
display the update progress. When complete the main logger 
status screen will be displayed.  
Also refer to  Chapter 6: Updating DataNet Software and 
Firmware. 

 
Note: Logger must be in Stop mode before firmware can be 
updated. 

Loading firmware  
Progress: 55% 

Fourier Systems 
No Parent found 
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4.13. Operating the Mini DataNet 
DNL804, DNL808, and 
DNL810 and DNR800 

Note: Mini DataNet keypad functionality has changed with the 
release of firmware version 2.30. 

This section explains how to operate the DNL804, DNL808, 
DNL810 and DNR800 Mini DataNet units using the multi-
functional button on the logger front panel. There is no LCD 
screen on the Mini DataNet models.  
Ensure the device Serial Number has been added to the 
Device Filter before continuing. Refer to section  3.5.3. 
A useful tip for remembering the LED functionality is that a 
green LED indicates a logger turning on or joining a network, 
and a red LED indicates a logger is shutting down or leaving a 
network. 

4.13.1. Turning Mini DataNet Units Off  

DNL804, DNL808 and DNL810 
To conserve battery, the Mini DataNet LED does not provide 
an indication of on/off status. If you wish to operate the logger 
it is best to first be sure the unit is turned off before continuing. 
To turn the unit off: 
1. Press and hold the logger button until the LED emits a 

fixed, red light for at least three seconds. 
2. Release the logger button.  
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DNR800 
The DNR800 Mini Repeater is powered by external AC power 
supply only. There is no battery backup. When disconnected 
the unit is shutdown immediately and is disconnected from the 
network.  

4.13.2. Turning Mini DataNet Units On 
and Joining a Network 

DNL804, DNL808 and DNL810 
The action of turning on a unit means that it will also join a 
network. 
When the unit is off: 
1. Give the logger button a short press.  
2. The logger will search for a network. The LED will blink 

green at one second intervals until either of the following 
two scenarios occurs: 

 The logger automatically finds a network. The LED 
will be fixed green for five seconds and the logger icon 
will display and blink for eight seconds in the software 
Map View. 
The logger will connect to the first network it find 
which recognizes its Serial Number, as entered in the 
Device Filter. 
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 The logger doesn't find a network. After 60 seconds   
of failed attempts to find a network, the logger will shut 
down. 

Note: The logger won’t find a network if its serial 
network wasn’t entered in the Device Filter, the 
Receiver isn’t online or if the network is locked (go to 
the Network menu to unlock). 

3. Once the logger has joined the network you may 
configure it to start recording data. Refer to section  5.15. 

 

DNR800 
The DNR800 functionality for joining a network is the same as 
for the other Mini DataNet units. The only difference is that to 
turn on the Mini Repeater, you can also just connect the unit 
to its external power supply. When turned on it will 
automatically search for networks. 

4.13.3. Rescanning for Networks 

If the unit has joined another network i.e. not yours, then you 
will have to leave that network and rescan for new networks. 
This requires first shutting off the unit and then leaving the 
current network.  
1. Make sure the unit serial number is entered into the 

Device Filter.  
2. Turn the unit off by pressing and holding the unit button 

until the LED emits a fixed, red light for at least three 
seconds. 

3. Release the unit button. 
4. To leave the network, press the unit button again for three 

seconds. The LED will blink red three times to indicate 
Leave Network command has been received. The unit 
icon will be removed from the software Map View.  
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5. To rescan for network, give the unit button a short press. 
The unit will search for a network and will indicate it has 
joined a network by emitting a solid green LED for five 
seconds. 

Note: If there are multiple DataNet networks in your 
environment make sure that the unit SN is listed in the Device 
Filter of only one of these networks, otherwise you can’t 
control which network it will join first and you will have to 
rescan the networks several times. 

4.13.4. Leave Network  

To leave the current network, when the unit is on: 
1. Press and hold the unit button until the LED emits a fixed, 

red light for at least three seconds. 
2. Release the unit button. 
3. To leave the network, press the unit button again for three 

seconds. The LED will blink red three times to indicate 
Leave Network command has been received. The unit 
icon will be removed from the software Map View. The 
unit is now off. 

4.13.5. Running Signal Test 

You may run a signal test on the logger or Mini Repeater to 
check the signal strength to the parent unit. 
Right-click the unit icon on the Map View and select the 
Signal Test option. The signal test will be performed on the 
unit with the following parameters indicating signal quality: 
• Good: LED blinks orange at for 0.5 second intervals 
• Low: LED blinks orange at one second intervals 
• Unit is out of range: LED emits steady orange light   
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Note: Power consumption of logger battery during signal test 
increases significantly so do not overuse this feature.  

4.13.6. Call Unit from Software 

To locate the unit via the software, right-click the unit icon on 
the Map View and select the Call Device (LED) option. The 
unit LED will alternate between slow green and red blinks and 
after several blinks it will stop.  

4.14. Operating the DNR900 in 
Receiver Mode 

This section explains how to operate the Receiver using the 
menu options on the units’ LCD screen, as how to change the 
DNR900 unit type from Receiver to Repeater.  

4.14.1. Turning on the Unit 

In order to view the Receiver menu options, the unit must be 

turned on by pressing the Scroll button  on the keypad. 
Ensure the unit is charged or connected to the AC adapter. 
Once the unit is turned on it will display a series of status 
messages, finishing with the welcome screen below: 

 

Receiver 
ID:  021.180.012 



 
 

89 

4.14.2. Receiver Menus 

When the unit is selected to work as a Receiver (as opposed 
to working as a Repeater) the following menus are displayed 
on the unit. 
Unit Name 
When the unit is switched on the following screen is 
displayed, indicating unit mode (Receiver) and the unique 
network ID formed by this Receiver. 

 
Receiver version 
This menu informs the user of the Receiver firmware version. 
This is helpful when you need to upgrade the system 
firmware, to check the current version. Or when contacting 
Fourier technical support, with any technical issues. 
 
Change Unit Type to Repeater 
Refer to section  4.14.3 for more details.  
 
Reset Unit    
When the unit is reset, upon start up it will reconnect the 
network it previously formed and managed.  

 
 

Reset unit 

Receiver 
ID:  021.180.012 
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Turn Off Unit 
Selecting this option will shut the unit down. You can turn the 
unit on again by pressing the Scroll button. When the 
Receiver is shutdown the network will be down as well, as the 
end units won’t be able to transmit to the Receiver. 

 
It is recommended to turn off the unit when it is not in use. 

4.14.3. Changing Receiver to Repeater 

Scroll through the Receiver menu until you reach the menu 
Change Unit Type to Repeater. 

 
 
Press the Enter button to proceed with changing the unit to 
Repeater mode. Once you perform this action, any network 
the unit may have formed while in Receiver mode will be 
down, and you will need to form a new network with another 
Receiver unit, and join your existing loggers to that new 
network. 

Note: Once you change the Receiver to a Repeater, you will 
only be able to download data from loggers on the Receiver’s 
network via direct USB connection or by using the Substitute 
Receiver feature (see section  4.15.6). 

Once the unit is in Repeater mode, you will need to leave the 
network it is connected to, and scan for a new network. Only 

Change unit type 
to Repeater 

Turn off unit 
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once the Repeater joins the network will other units on that 
network detect it.  
Refer to section  4.15 for more details on operating a Repeater 
and joining a new network.  

4.14.4. Additional Receiver Screens 

Loading Firmware  
When updating the firmware of the Receiver via the software’s 
Firmware Update Center, the Receiver screen will display the 
update progress. When complete the main Receiver status 
screen will be displayed. 

 

4.15. Operating the DNR900 in 
Repeater Mode 

This section explains how to operate the Repeater and 
provides an overview of the menu options on the units’ LCD 
screen. 
Refer to section  4.14.3 to learn how to switch the DNR900 
from Receiver to Repeater mode. 

4.15.1. Turning on the Unit 

In order to view the Repeater menu options, the unit must be 

turned on by pressing the Scroll button  on the keypad. 
Ensure the unit is connected to the AC adapter. 

Loading firmware  
Progress: 55% 
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Once the unit is switched on it will emit a short beep and the 
screen will display a welcome message:  

 

4.15.2. Display Shutdown 

When the Repeater is running from batteries only, if the 
screen is inactive for thirty seconds it will turn off. However the 
Repeater will continue to operate in the background. Press 
the Scroll button to enable the LCD screen again. The screen 
will not turn off during firmware upgrade. 
When connected to external power supply the Repeater 
screen will always stay on. 

4.15.3. Joining a Network 

When a Repeater is powered on or reset, it will automatically 
scan for a network after the welcome message has appeared.  
There are four scenarios that can occur while scanning for a 
network: 
Scenario 1: The unit can’t find the last network that it was 
connected to. For example, the Repeater is a new unit which 
was never previously joined a network. 
Scenario 2: The unit scans and finds the last network it was 
connected to, and joins that network. 
Scenario 3: The unit can’t find any networks at all. 
Scenario 4: The unit found a network but failed to join. 
 
Read below for more details on each scenario. 

Fourier Systems 
Ready 



 
 

93 

Scenario 1 
If the unit can’t find the last network that it was connected to 
(for example, it’s a new unit), the unit will display all the 
networks that are in range: 

 
Where # is the number of networks found 
 
Once the scan has been completed the following screen 
appears: 

 

If more than one network was found, the user will need to 
select the network ID that he wants to connect to. The user 
uses the Scroll button to scroll through the Network IDs. The 
relevant network is selected using the Enter button.  

Network 1:
ID: 014.061.082  

Network 2:
ID: 021.207.175  

Network 1:
ID: 014.061.082  

Network 2:
ID: 021.207.175  

Rescan networks

 

Once the network has been selected the following screen will 
be displayed. 

 
 

Scan complete   
 

Scan for network 
 

Scan for network  
Found # network 

Joined network: 
ID: 021.207.175   
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To rescan the networks, simply select the Rescan Networks 
option and the logger will start the scanning process again. 
 
If only one network was found the system will automatically 
connect to that network without the user needing to select the 
network manually. 

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

Scan for network 
Found 1 network

Scan complete  Joined to network:
ID: 021.207.175  

 

The Repeater display will return to the welcome message, 
which consists of the Repeater name (editable via the 
software) and the network status: 
Ready - If connection to the DataNet software is established. 
Software is down - If established connection to the Receiver 
but the DataNet software is down (PC is off, software is not 
open, etc.) 
No Parent Signal – The parent unit, either the Receiver or 
another Repeater, is not detected by the Repeater therefore it 
is not transmitting its data to the network. 

 

Fourier Systems
Ready

Fourier Systems
Software is down

Fourier Systems
No Parent Signal

Fourier Systems
Ready

Fourier Systems
Software is down

Fourier Systems
No Parent Signal

 

The Repeater will continue to search for the parent unit (at 
specific intervals) and the screen will continue to read Search 
Parent until the parent is found. 
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Scenario 2 
When the system scans for networks and finds the last 
network that it was connected to it will automatically connect 
to the last known network. 

 

As in Scenario 1, the logger display will then return to the 
welcome message displaying the unit name and status.  
 

Scenario 3 
The system can’t find any networks at all. 
If no networks were found, the unit will display the following 
screens. 

Scan for network 
Found 0 network

Scan complete  No found networks:
Rescan networks 

 

Joined Network: 
ID: 021.207.175   



 
 

96 

Scenario 4 
The unit found a network but failed to join. 
The unit will perform up to 99 retries to join the network before 
scanning for networks again. Press any of the unit buttons to 
cease the attempts to join the network. 
A unit may fail to join a network if it is far from the Receiver, 
requiring several hops to reach the Receiver, or the network 
itself is large with many units. The attempt to join a network is 
made in under a second in real-time and on high traffic 
network, it may result in failure to join.  
Moving the unit closer to the Receiver can help the logger to 
join successfully. If the logger still can’t join, form a new 
network or contact Fourier technical support. 

4.15.4.  Menu Options 

Use the Scroll button to scroll through the menu options.  
Name and Status 
The unit name is displayed on the first row and the second 
row indicates the Repeater status.  

 
 
Mark Unit on PC 
To indicate the Repeater icon in the software’s Map View, 
press the Enter button when this screen is displayed. The 
Repeater’s icon located in the Map View will blink a number of 
times. 
 

Fourier Systems 
Ready 
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Batt Level (battery level) 
• If the power adapter is not connected the battery 

percentage will be displayed. 
• If the power adapter is connected Battery charging will 

be displayed.  

 

Signal Level Test   
The Signal Level test allows the user to check the signal 
strength and quality of the link between the Repeater and its 
parent unit. This test is used to determine optimal positioning 
of the Repeater during deployment.  

 
 
By pressing the Menu button the unit will show the signal level 
and link quality in percentage terms. 
If there is no connection with a parent unit, an Out of range 
message will be displayed. 

 

• Signal level: Indicates the reception level between end 
unit and parent unit. If the level falls below 20% then the 
logger should be placed in a better location or another 
Repeater should be added. 

Out of range 
 

Signal level:   80 
Link quality:   95 

Batt Level:      
Battery charging 

Batt Level:     67% 
 

Signal level: 
Run test -> Menu 
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• Link quality: Calculation of the data transmitted with no 
errors from the Repeater to the parent unit. If the level 
falls between 85% then the Repeater should be placed in 
a better location or another Repeater should be added. 
The lower the link quality %, the more retries are needed 
in order for the Repeater to send all of its data. 

Note: The signal level may be low but the link quality can still 
be 100%. 

 
You will not be able to run the Signal Level test when the 
Repeater has lost its connection to the network. If you tried, 
then the following screens are displayed: 

 
Firmware Version  
This menu informs the user of the Repeater firmware version. 
This is helpful when you need to upgrade the system 
firmware, to check the current version. Or when contacting 
Fourier technical support, with any technical issues. 

 
The firmware version is commonly referred to by the numbers 
in bold in the screen above. For example, the firmware 
version which is supported by this user guide is v2.30.  
 

No Parent signal Fourier Systems  
No Parent found  

Firmware version: 
1.03.01.02.30.00 
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S/N 
This menu displays the unit’s eight digit SN. 

 
 
Network Data 
This menu displays the unique network ID to which the unit is 
currently connected. This ID will match the network ID 
displayed in the software in the Receiver icon’s tooltip in the 
Map View. 

 
 
Go to Substitute Receiver Mode 
Refer to section  4.15.6 for more details. 
 
Change Unit Type to Receiver 
Select this option to change your unit from Repeater to 
Receiver mode. A new network ID will be formed.  

 
Press the Enter button to proceed with changing the unit to 
Receiver mode. 
 

Change unit type 
to Receiver 

Network data: 
ID: 014.061.082 

S/N 12345678 
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Leave Network  
If this option is selected, the unit will first leave the network 
and then reset itself. The scan network procedure described 
in section  4.12.3 will begin. The only exception to this 
procedure is that even if the last connected network is found 
during the scan, the unit will not automatically connect to it.  

 
 
Reset Unit  
When the unit is reset, upon start up it will automatically scan 
for networks. The unit will automatically connect to the 
previously connected network assuming it was found in the 
network scan. 
 
Turn Off Unit 
Selecting this option will shut the unit down. You can turn the 
unit on again by pressing the Scroll button. 
It is recommended to turn off the unit when it is not in use. 

 
Note: Turning off the Repeater can have adverse affects on 
your network, as other units may be dependent on the 
Repeater for transmitting its data to the Receiver. To prevent 
the Repeater from being a point of failure if shut off, ensure 
the network is robust enough by having alternative routes for 
the end units to reach the Receiver.  

Turn off unit 

Leave network 
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4.15.5. Additional Repeater Screens 

Unit Beep 
When the DataNet software activates the Call Unit feature, the 
Repeater will beep and the following screen will be displayed:  

 
Refer to section  5.14.5 for more details. 
 
No Parent Signal/No Parent Found 
When a Repeater’s parent unit, such as another Repeater or 
the Receiver, goes offline then the following screen is 
immediately displayed on the logger: 

 
For example, this could happen if the Receiver managing the 
network has formed a new network, so there is no Receiver 
managing the previous network. Or if the parent unit is a 
Repeater, and it goes offline, then this Repeater will display 
the message above.  
Once it has determined that the parent signal is lost, it will try 
to establish a connection with the network via another 
Repeater but if it fails then the following screen is displayed: 

 
 

Unit Beep 
Fourier Systems 

Fourier Systems 
No Parent found 

No Parent signal 
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You will have to leave the current network and rescan for a 
new network. 
 
Loading Firmware  
When updating the firmware of the Repeater via the 
software’s Firmware Update Center, the Repeater screen will 
display the update progress. When complete the main 
Repeater screen will be displayed. 

 

4.15.6. Working in Substitute Receiver 
Mode 

In the event that the network Receiver suffers hardware 
failure, is damaged or cannot operate for any reason, the 
DataNet network cannot function as an online monitoring 
system.  
In such an event any network with a functioning Repeater can 
restore network functionality i.e. transmission of data from 
logger to software, by using the Repeater to temporarily 
replace the Receiver.  
By doing so, the Repeater will be defined as a Substitute 
Receiver, maintaining the original network ID, and full 
Receiver functionality except for the ability to add new loggers 
to the network. Until a new, permanent Receiver is obtained, 
this feature provides an excellent backup enabling continuous 
data transfer preventing the time consuming task of moving all 
devices to a new network.  
To enable Substitute Receiver mode: 
1. Ensure the original network Receiver is switched off. 

Loading firmware  
Progress: 55% 
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2. Connect the Repeater to the PC via mini-USB cable. 
3. From the Repeater menu, select Go to Substitute 

Receiver mode. 
4. The LCD screen will display Sub Receiver and the 

network ID. To move to standard Repeater mode, select 
Change unit type to Repeater from the menu. 

 

4.16. Data Logger Memory 
Management 

All DataNet data loggers operate using a cyclic memory 
mechanism. When the logger memory is full, the logger will 
not stop recording data. It will continue by writing over the first 
samples recorded to the logger memory. 
As DataNet is an online monitoring system, the logger data is 
regularly transmitted to the Receiver, so any erased samples 
will already be safely recorded to the DataNet data file folders.  
The only scenario where data may be erased is if the 
Receiver is offline for a period longer than the data logger’s 
Recording Time (as displayed in the Setup dialog). The 
Recording Time indicates how long the logger can record data 
for until the memory is full. In this case, the logger memory will 
fill up and due to the cyclic mechanism, start erasing the first 
recorded samples. Any samples not transmitted to the 
computer will be permanently lost. It must be noted that this 
scenario is highly unlikely. 
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Chapter 5:  
Using the DataNet 
Software  

This chapter provides detailed description of 
the DataNet software features, allowing you 
to manage your DataNet network and 
perform a variety of actions on your data 
loggers, such as setup, calibration, defining 
new sensors, managing Email and SMS 
notifications, configuring reports, firmware updates and so on. 

5.1. Installing DataNet 
Software 

Part of your DataNet package includes a DataNet software 
CD. Follow the software installation instructions provided 
below.  

5.1.1. System Requirements 

To work with DataNet your system should be configured 
according to the following specifications: 

Software 
• Windows XP SP2, Windows Server 2003 SP2, Windows 

Vista (32-bit) or Windows 7 (32-bit) 
• Internet Explorer 5.01 or higher 
• Minimum screen resolution: 1024 x 768 (800 x 600 not 

supported) 
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Hardware 
• Pentium 800 MHz or higher  
• 512 MB RAM  
• 250 MB available disk space for the DataNet application  

5.1.2. Language Support 

DataNet currently supports English, Italian, French and 
Spanish language interface. Additional languages will be 
added in future DataNet versions. 
To toggle the software language, go to Help > Language. 
You must then exit DataNet for the changes to take effect.  

5.1.3. Installation Procedure 

Please read these instructions before proceeding with the 
installation process. 
1. Insert the DataNet software CD into your computer’s CD 

drive. The DataNet Installation Wizard automatically starts 
running. 

2. The Wizard first installs Microsoft .NET Framework 2.0. 
The DataNet software requires this platform in order to 
run. Follow the installation instructions to install the .NET 
Framework on your PC. This step can take up to two 
minutes to complete. Click Finish once installation is 
complete. 

Note: If .Net Framework is already installed on your 
computer this step is skipped. 

3. The main DataNet Installation Wizard now resumes. 
Follow the installation instructions to install DataNet on 
your computer.  
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4. Following DataNet software installation is the Silicon 
Laboratories USB driver installation. The driver is 
necessary for the computer to detect the DataNet 
Receiver hardware.  
Follow the on-screen instructions to continue the 
installation process. The default installation location is 
C:\SiLabs. 

 
Figure 31: Installing Silicon Labs USB driver – Step 1  

5. During the driver installation, the following window will pop 
up. Make sure to select the checkbox to launch the driver 
installer, and click Finish. 

 
Figure 32: Installing Silicon Labs USB driver – Step 2 
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6. In the subsequent window, click Install to install the 
driver. 

 
Figure 33: Installing Silicon Labs USB driver – Step 3 

 
The installation of the driver could take up to one minute 
or more, depending on the system.  

 
Figure 34: Installing Silicon Labs USB driver – Step 4 

 
7. Once installed click Finish to close the USB driver Install 

Wizard dialog. 
8. The DataNet software and components have now been 

installed. Double click the DataNet shortcut on your 

desktop  to launch the software. 
9. The DataNet software registration window will open. 

Select the option to continue to DataNet and work in Trial 
mode. The registration can be completed at a later stage. 

10. You will be prompted to confirm the location of the 
DataNet data files and DataNet data text files folders. The 
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default location is C:\Program Files\Fourier 
Systems\DataNet. Click OK, or modify the path and then 
click OK. 

11. Once DataNet opens, connect the DataNet Receiver to a 
USB port on your computer. It will automatically detect the 
Receiver as new hardware. After a few seconds you will 
see a message stating that the device is ready for use. 
You may now begin to configure your DataNet network.  

5.1.4. Working with Multiple User 
Accounts 

If the computer running DataNet will be accessed by more 
than one user account e.g. Administrator, User1 and User2, to 
ensure stable operation of the DataNet system, the DataNet 
directory should be shared with full read/write permissions for 
all users.  
Otherwise, any user who is not an Administrator won’t have 
access to the Settings.dns file located in the DataNet directory 
and won’t be able to access logger data, and when starting 
the DataNet all units may appear offline.  

5.1.5. Installation Troubleshooting 

When connected to the PC USB port the Receiver was not 
detected by the software. 
Ensure that the USB driver was installed properly.  
Go to Control Panel > Add/Remove Programs (in WinXP), 
and check that the driver is installed: 
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If not, you should run the Silicon Labs setup file to install the 
USB driver: CP210x_VCP_Win2K_XP_S2K3.exe setup.exe to 
install the driver.  
 
If the driver is installed, ensure that there is no other device 
sharing the USB com port with the DataNet Receiver.  
If you didn’t select the Launch CP210x VCP Driver Installer 
checkbox during step 2 of the driver installation wizard (see 
section  5.1.2), then the driver wasn’t installed. Run the wizard 
again and be sure to select the checkbox. 

5.2. DataNet Login 

When launching the DataNet CFR software, the user is 
required to login to the system so that the system 
Administrator is able to follow user activity in the DatPass 
Admin software audit trail (per FDA regulations). 
1. Prior to running DataNet for the first time, the Admin must 

create a new user in the DatPass software. Once this is 
done, you may launch the DataNet software. 

2. The Login dialog will open. For first time login, click New 
User.  

 
Figure 35: User Login Dialog 
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3. Select the user via the drop-down menu, and proceed to 
enter the username and password associated with that 
user profile. 

Note: If the system prompts No New Users message, then 
request your DataNet system administrator to create a new 
user in DatPass. 

4. Click OK. 
5. Once logged into the DataNet software, you will only have 

access to those features for which the Administrator has 
granted privileges. 

6. To log off from the system, go to File > Logoff. The login 
dialog will remain open in case you wish to login again. 

5.3. DataNet Software 
Registration 

From DataNet v2.0.0.0, Fourier Systems requires all DataNet 
software to be registered within 30 days of installation, using a 
serial number provided with purchase of the DataNet PC-
SUITE.  

Note: The software activation feature will enable Fourier to 
eliminate any unauthorized DataNet software installations and 
prevent distribution of pirated CDs containing the software. 

When the initial 30 day Trial period is over, the user will not be 
able to operate the software until a valid serial number is 
registered.  
Please note that: 
• Each serial number is good for unlimited installations on a 

single computer. You cannot install the software using the 
same serial number on another computer.  
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If you have replaced your computer and must reinstall 
DataNet using the same serial number, contact Fourier 
Customer Support for assistance. 

• Registration can be performed from the computer with 
DataNet installed, or if there is no Internet connection 
from that computer, then via another computer with 
Internet connectivity. 

5.3.1. Software Registration Process 

Note: The software registration forms are all case sensitive. 
Incorrect entry will result in invalid registration.  

Whether installing DataNet for the first time or upgrading from 
a previous version, from v2.0.0.0 all users must register the 
software. To register DataNet, follow the instructions below: 
1. Locate the software serial number (SN). The SN label is 

found on the PC SUITE box as well as on the software 
CD case. 

Note: If you cannot locate your serial number, contact your 
Fourier distributor or Fourier Customer Support directly. 

2. Launch DataNet. The registration wizard will open, 
displaying the number of days remaining in the Trial 
period.  
To open the registration wizard from within DataNet go to 
Help > Register. 
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Figure 36: Software registration wizard  

 
3. The wizard presents three choices. Select the relevant 

option and click Next to proceed: 
 Activation via the Internet 

Select to proceed with registration on the same 
computer on which DataNet is running, ensuring it has 
a live Internet connection. 

 Activation via an Internet connection on another 
computer  
Select if the computer on which DataNet is running 
does not currently have Internet connectivity.  
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 Continue to Fourier Systems DataNet  
Select to exit the registration process and continue 
working in DataNet. You will continue to work in Trial 
mode.  

4. After selecting one of the two available options for 
continuing with the registration process, and after clicking 
Next in step 3 above, you will be prompted to enter the 
software SN. Enter the SN and click Next. 

Note: Each serial number provides a single user license. 
You cannot use a serial number already registered on 
another computer.  

5. The registration process now differs, depending on which 
option was selected in step 3 above. Read the relevant 
section below for further registration instructions.  

 

Activation via the Internet 
1. After entering the software serial number, a window 

requesting basic personal information will open. Enter the 
mandatory fields and click Next.  
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Figure 37: Personal information registration window 

2. DataNet will now establish communication with the 
Fourier Systems server to complete the registration 
process. If successful, a confirmation message will 
appear. In the event of any problem in the registration 
process, please contact your Fourier distributor or Fourier 
Customer Support.  

3. Click Close to return to the DataNet software. 
 

Activation via Internet Connection on 
another Computer 
1. After entering the software serial number, a window 

providing additional registration instructions will open.  
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Figure 38: Activating DataNet from another computer 

 
2. Follow the steps as outlined in the window.  

Note: It is recommended to generate a text file containing 
both the Application Key and the Web registration form 

URL. Press the  icon. Transfer this file to the 
computer with Internet connection, as the registration 
process must be continued from there.  
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3. Record the License Key obtained from the Web 
registration form. Enter it into the License Key field in Step 
3 and click Unlock. 

4. DataNet will now establish communication with the 
Fourier Systems server to complete the registration 
process. If successful, a confirmation message will 
appear. In the event of any problem in the registration 
process, please contact your Fourier distributor or Fourier 
Customer Support.  

5. Click Close to return to the DataNet software. 

5.4. DataNet Software Layout  

This section provides an overview of the default DataNet 
window view as well as a guide to all of the icons available 
throughout the software. 
The most commonly used tools and commands are displayed 
on two toolbars. Tools that relate to all aspects of the program 
are located in the main (upper) toolbar. Tools specific to the 
graphs are located on the graph (lower) toolbar.  
Refer to section  5.4.5 for a description of these toolbars 

5.4.1. Map View  

When DataNet is first launched, the default window that is 
opened is the Map View (see screenshot below). 
You can also switch to Map View at any time by clicking the 

Map View button  in the main toolbar. In addition, the Map 
View can be printed. 
This view is used to monitor the location and network 
connection of all of the data loggers and Repeaters in the 
network, in addition to the Receiver.  
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Icons are used to represent each of the DataNet units, and 
using the mouse the user can select specific actions to be 
performed on the unit. 
Name tags can also be displayed for each icon on the Map 
View. 
 

 
Figure 39: Main window - Map View desktop 
 
Refer to section  5.14 for more details on working in Map View. 

5.4.2. Sensor View 

Clicking the Sensor View button  in the main toolbar 
switches the main DataNet window to a display where sensor 
data is represented in individual windows. All sensors which 
are currently online will be displayed in this view. If a logger is 
currently offline then its data will not be visible. 
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Figure 40: Main window – Sensor View 
 
There are two modes for viewing the sensor data, which may 
be toggled by going to Tools > Switch Sensor View Mode in 
the main menu.  
• Expanded view 

 
In this view, the logger comment, sensor type and sensor 
data is displayed. 
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• Slim view 

 
In this view, only the sensor type and sensor data is 
displayed. 

 
Sensor in Alarm 
When the sensor data is in alarm, the color of the sensor 
window will change according to the alarm type. There is a 
legend in the lower right corner of the main window: 

 
For example: 

 
This screenshot indicates that the Internal Digital Temperature 
reading is in High alarm, while the Internal Relative Humidity 
reading is at normal levels. 
 
Additional Features 
• The sensor windows may be dragged and placed 

anywhere on the screen. 
• Double clicking the sensor window will open the Data 

Display window, where the real-time sensor data is 
displayed in graph or table view. 

• When the logger is downloading data, a message in the 
sensor window will be displayed. 
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• Scrolling over the sensor window with the mouse cursor 
will bring up a tooltip displaying the following data: 
 Serial number 
 Logger comment 
 Battery level 
 Last sample time 
 Sensor type and reading 
 Downloading data indication (when relevant) 

 

 

5.4.3. History View 

Clicking the History View button  in the main toolbar will 
switch the main window to view archived, offline data stored in 
the DataNet directory on the workstation. 
You must first open the archived data file by clicking Open 

File on the main toolbar. When you open the data file it 
will be displayed in the History View, otherwise, the History 
View window will be blank.  
Refer to section  5.12: Viewing Archived (Offline) Data on page 
150 for more details on opening files in History View. 
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Figure 41: Main window – History View 
 
In History View, the user may view the data in graph or table 
format by clicking the relevant tabs, as well as view a number 
of Statistics taken from the data set.  
To learn the functionality of the lower graph toolbar, refer to 
section  5.4.5 below. 

Note: Users of Windows 7 using right to left language settings 
e.g. Hebrew, may have problems viewing the Date/Time in the 
DataNet graph. This is a know Microsoft ® bug. Until a bug fix 
is released, change the Regional Settings to English. 

5.4.4. Data Map 

The History View window also includes the Data Map pane, 
on the left of the window. 
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The Data Map displays all data sets opened in History View, 
saved in the current project file, and includes nodes for each 
sensor in the data set.  
Clicking the sensor label removes the data from the graph. 
When the label is black, the data is not displayed on the 
graph. The sensor data plot color is matched to the color of 
the sensor label in the Data Map.  

Each data set is preceded by a Logger icon , which can 
be expanded or collapsed to display the associated sensor 
data. 

Clicking the Tree icon  in the lower graph toolbar removes 
the Data Map pane altogether allowing a full screen graph 
view. 

 
Figure 42: Data Map 

5.4.5. DataNet Toolbar Icons 

This section outlines all of the toolbar icons available in the 
software. 
 

Data Map 
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Main (Upper) Toolbar Icons 

 

 
Figure 43: Main toolbar icons 
 
The main toolbar is always available at the top of the DataNet 
application, no matter what window view the user is in.  
This toolbar cannot be moved or hidden. 

•  Open file - Opens archived logger data file 
stored on the PC 

•  Map view - Switches main window to Map 
view, where the units connected to the DataNet 
network are represented 

•  Sensor view - Switches main window to 
Sensor view, where data from each running 
sensor is displayed in a simple view 

•  History view - Switches main window to 
History view, where archived logger data can 
be viewed and analyzed 

•  

 

Alarm mute/unmute - Mutes or unmutes an 
audible alarm in the system when a sensor 
reading has breached the user-defined alarm 
level 

•  Email Alarm Notifications - Configuration 
window for Email alarm notifications 

•  SMS Alarm Notifications - Configuration 
window for SMS alarm notifications 
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•  

 

GSM Modem - Indicates if GSM modem is 
connected (green icon) or disconnected (grey 
icon) 

•  Alarm Reason - Indicates if there are alarm 
events without an assigned alarm reason  

•  Temperature unit toggle - Display all data in 
Celsius  

•  Temperature unit toggle - Display all data in 
Fahrenheit 

•  Reports Profile Manager – Opens Reports 
module 

•  Report Browser – Opens window for browsing 
saved Reports 

Table 3: Main toolbar icon list 
 

Map View Icons 
The following icons representing the various statuses of the 
DataNet units are viewed in Map View. Using these icons the 
user is aware of the online/offline status of each unit, as well 
as the battery level and signal level of the loggers and 
Repeaters.  
Alarm status is also indicated: Green = Normal ; Red = Alarm 
 

• 
 

Receiver is online and connected to the PC. 

• 
 

Receiver is offline, possibly as USB cable has 
been disconnected or it was removed from 
external power supply (and backup battery 



 
 

125 

drained). 

• 
 

Logger newly acquired by network and 
awaiting Setup.  
Running from internal battery supply. 

• 
 

Logger newly acquired by network and 
awaiting Setup.  
Running from external power supply. 

• 
 

Logger which has received its Setup but is in 
Stop mode. 
Running from internal battery supply. 

• 
 

Logger which has received its Setup but is in 
Stop mode. 
Running from external power supply. 

• 
 

Logger in Run mode and running on internal 
battery supply. 
Green indicates there are no alarms. 

• 
 

Logger in Run mode and running on external 
power supply. 
Green indicates there are no alarms. 

• 
 

Logger in Run mode with an alarm alert. 
Running from internal battery supply.  

• 
 

Logger in Run mode with an alarm alert.  
Running from external power supply. 

• 
 

Logger is offline and is no longer detected on 
the network. Its power supply may have failed 
or it’s out of range of the Receiver. 

• 
 

Logger is processing a command sent from the 
software. 
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• 
 

Logger is downloading data. 

• 
 

Logger is detected by DataNet software via 
direct USB connection. Logger is in Stop mode 
and running from internal battery supply. 

• 
 

Logger is detected by DataNet software via 
direct USB connection. Logger is in Stop mode 
and running from external power supply. 

• 
 

Logger is detected by DataNet software via 
direct USB connection. Logger is in Run mode 
and running from internal battery supply. 

• 
 

Logger is detected by DataNet software via 
direct USB connection. Logger is in Run mode 
and running from external power supply. 

• 
 

Repeater is online and is running from external 
power supply. 

• 
 

Repeater is offline and is no longer detected on 
the network. Its power supply may have failed 
or it’s out of range of the Receiver. 

• 
 

Repeater is detected by DataNet software via 
direct USB connection. 

Table 4: Main toolbar icon list 
 

Graph (Lower) Toolbar Icons 
The graph toolbar is located at the bottom of the open graph 
view, when the user is either in Online Data Display: 
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Or History View: 

 
 
The toolbar cannot be moved or hidden. 

•  
Data Map (in History View only) – Hides or 
shows the Data Map pane in the History View 
window. 

•  
Plot Legend (in Display Data View only) – 
Hides or shows the sensor labels from the 
bottom of the graph. 

•  
Autoscale - Returns the data to its default 
scale. 

•  
Zoom in – Zooms in on the graph data. 

•  
Pan graph – Pans the graph along the x or y 
axis. 

•  
Select first cursor – Adds a cursor to the 
designated plot on the graph 

•  
Select second cursor – Adds a second cursor 
to the designated plot on the graph. 

•  
Grid – Adds a grid to the graph background 

•  
Add Custom View (in History View only) – 
adds the open, customized graph view to the 
Data Map 

•  
Copy graph – Copies the graph to your 
clipboard, to be copied to a document or 
spreadsheet, for example. 

•  
Graph properties – Opens the Graph 
Properties window.  
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•  
Export to Excel – Export the open data sets to 
Excel format. 

•  
Print – Opens the Print dialog. Available for 
graph, table and statistics views. 

Table 5: Lower graph toolbar icon list 
 

Data Map Icons 

• 
 

Displayed internal Temperature sensor data 
set 

• 
 

Hidden internal Temperature sensor data set 

• 
 

Displayed internal Humidity sensor data set 

• 
 

Hidden internal Humidity sensor data set 

• 
 

Displayed external sensor data set 

•  
Hidden internal sensor data set 

• 
 

Displayed graph function 

• 
 

Hidden graph function 

•  Parent node for all logger data sets. Click to 
expand or collapse all child nodes. 

• 
 

Logger data set. Click to expand or collapse 
the data set containing all measured inputs of 
the specific logger. 

•  
Parent node for all custom graph views. Click 
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to expand or collapse all child nodes. 

• 
 

Displayed custom graph view. When hidden 
the icon is grayed out. 

Table 6: Data Map icons 

5.5. File Menu Items 

5.5.1. Open 

Select Open to access archived data files for each logger in 
your network. 

Shortcuts: You can also click the Open icon  or press 
Ctrl+O to open archived files. 

5.5.2. Open Project File 

Opens project files of offline data, containing data from one or 
more loggers, as opposed to standard data files containing 
data from only one logger. 

5.5.3. Save Project 

Saves multiple data sets and custom graph views into a single 
Project File. Only available in History View. 

5.5.4. Save Project As 

Saves an existing Project file under a different name. 
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5.5.5. Print Map View 

Prints the current Map View with all unit icons, including their 
network paths and name tags. 

5.5.6. Exit 

Exits the DataNet application.   

5.6. Network Menu Items 

Most of the Network menu items are also accessible via the 
Receiver context menu, by right-clicking the Receiver icon in 
Map View. 

5.6.1. Detect Receiver 

When the Receiver is connected to the USB port it is 
automatically detected by the software. If you connect the 
Receiver while it is switched off, and then switch the Receiver 
on, the software won’t detect the unit. You will have to use the 
Detect Receiver feature. 
The Receiver may also lose power and go offline while 
connected to the USB, in which case you will also need to 
detect it manually. 
If no Receiver is detected by the software an error message 
will pop up stating that the Receiver was not detected. 
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5.6.2. Detect Logger/Repeater 

When the DNL910, DNL920 or DNR900 Repeater is 
connected to the DataNet via USB, the Detect 
Logger/Repeater menu item is enabled.  
Connecting the data logger or Repeater to the computer via 
USB and selecting this menu item supports:  
• For DNL910 and DNL920: Direct data download, firmware 

update and turning off of the unit. Refer to section 
 5.14.6 6.2.4 regarding firmware update via USB.  

• For DNR900 Repeater: Firmware update. Refer to section 
 6.2.4. 

5.6.3. Lock Network 

By locking the network you do not allow any additional units to 
join the network. During the network scan, the logger will not 
even detect the network if it is locked. 
By unlocking the network you leave it open for any unit to join 
the network, even if you do not wish them to. 

5.6.4. Form New Network 

Select this option to form a new network using the current 
Receiver or another Receiver if you are building more than 
one network. The Receiver will then form a new network 
based on your RF environment. This will ensure optimal 
network performance. 
Refer to section  3.8 for more details on optimizing the 
performance. 
Once a new network is formed, any loggers connected to the 
old network will need to rescan and join the new network. This 
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must be done manually by going to each logger and resetting 
it via the LCD menu options. 

Note: Ensure all data is first downloaded from the loggers 
before forming a new network. Once a new network is created 
you won’t be able to recover the loggers’ data. 

5.6.5. Refresh Network Connections 

Use this feature to send a command to the Receiver to re-
establish connection to the end units in its specific network. 
This is useful when wanting to ensure the network 
connectivity is performing optimally without any delay or lag 
due to changes in environmental conditions or location of the 
end units. Such delays can explain logger icons not displaying 
the correct information or commands not being sent promptly 
to the end units. 

Note: The software automatically refreshes the network 
connections every 10 minutes. 

5.6.6. Show Network Paths 

While in Map View, enable this option to display the path that 
the RF signal of all units in the network takes to reach the 
Receiver. If Repeaters are used in the network it will show the 
signal routed via the Repeater, en route to the Receiver.  
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The paths are color-coded so you can also see the 
transmission strength. A legend appears at the bottom of the 
window.  

 
• Red = Low (0 to 23% strength) 
• Yellow = Medium (23 to 56%) 
• Green = High (56 to 100%) 
 
You can also enable this feature for specific loggers by 
opening the context menu on the Logger icon in Map View 
and selecting Show Network Paths. 

5.6.7. Device Filter 

When working with Mini DataNet units, in order for the device 
to be allowed onto the DataNet network, the device Serial 
Number must first be added to the Device Filter. 
Refer to section  3.5.3 for more details.  
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5.7. Logger Menu Items 

5.7.1. Stop All 

To stop all the online loggers in the Map View simultaneously, 
go to the Logger > Stop All menu item. Prior to stopping the 
loggers, DataNet will first download and data not already 
transmitted to the computer. 
This feature is password-enabled. 

5.7.2. Run All 

To run all the online loggers in the Map View simultaneously, 
go to the Logger > Run All menu item. Prior to running the 
loggers, DataNet will first clear the logger menu.  
This feature is password-enabled. 

5.8. Tools Menu Items 

5.8.1. Define Sensor 

DataNet enables the user to define custom sensors. This is a 
useful tool for when the data logger is communicating with 
many sensor types from different vendors.  
Any additional sensor that you would like to connect to the 
logger must comply with the following restrictions: 
The sensor’s output must be either voltage in the range of 0 to 
1 V, 0 to 50 mV, current in the range of 4 to 20 mA or Pulse in 
the range of 0 to 65535 pulses. 
1. Click Tools > Define New Sensor and the Define New 

Sensor dialog will open.  
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Figure 44: Define New Sensor dialog 

 

2. Click New to enable the fields. 
3. Select the Base sensor from the drop-down menu 

(depending on whether your sensor’s output is 0 to 1 
V, 0 to 50 mV, 4 to 20mA, or measuring pulses). 

4. Enter the sensor name and sensor unit. 
5. Enter two calibration values (two real values and the 

corresponding output values of the sensor). 
6. Click Save. 
7. To make any changes to the existing sensor 

definitions, stand on the sensor name and click Edit. 
Otherwise, click New to define additional sensors or 
click Close to exit the dialog. 
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To use the custom defined sensor: 
1. Enter the Setup dialog for the data logger you want to 

configure.  
2. Select the Input you wish to use and from the Sensor 

Type drop-down menu, select the custom sensor, which 
now appears in this list.  

3. Proceed with the setup as you would normally do. 

5.8.2. Switch Sensor View Mode 

While in Sensor View, selecting this option will switch the 
sensor view between large and small window sizes. By 
reducing the size of the sensor window you display only the 
sensor type and sensor data. Enlarging the size of the sensor 
window will display sensor type, sensor data and logger 
name. 

5.8.3. Lock Map View 

While in Map View, with Lock Map View selected the Map 
View icons are in a fixed position and can’t be moved. You 
must unselect this option in order to freely move the icons 
anywhere on the screen. This is essential if working with a 
custom background image.  

5.8.4. Options Menu 

Refer to section  5.9 for more details. 



 
 

137 

5.8.5. Manage Contacts 

The Manage Contacts dialog is where the user can add, edit 
and remove all contacts and groups to which DataNet Reports 
and Email/SMS notifications are sent.  
Refer to section  5.17.1 for more details regarding managing 
Contacts, and to section  5.17.2 for more details regarding 
managing Groups. 

5.8.6. Email Alarm Notifications 

The Email Alarm Notifications dialog is where the user can 
configure all notifications to be sent via Email to a predefined 
contact list. Refer to section  5.16 for details. 

5.8.7. SMS Alarm Notifications 

The SMS Alarm Notifications dialog is where the user can 
configure all notifications to be sent via SMS to a predefined 
contact list. Refer to section  5.16 for details. 

5.8.8. Firmware Update Center 

The Firmware Update Center is where the DataNet firmware 
updates are managed. Please refer to section  6.2 for more 
details. 

5.9. Tools > Options Menu 
Items 

The Options dialog is divided into three main tabs:  
• Preferences 
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• Email Settings 
• SMS Settings 

5.9.1. Preferences Tab 

  
Figure 45: Options > Preferences tab 
The Preferences tab includes the following options: 
 
Minimize DataNet to system tray 

When this checkbox is selected, the DataNet icon  will 
appear in the computer’s system tray in the lower right of the 
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screen when the application is minimized. Simply double-click 
the icon to maximize the application to full screen. 
 
Run DataNet on Windows Startup 
When this option is selected DataNet will automatically launch 
upon Windows startup. This feature is useful in the event 
where the computer unexpectedly resets and when it restarts, 
DataNet will launch and online monitoring of the DataNet 
network will be able to continue. 

Note: If running Windows Vista, User Account Control (UAC) 
must be turned off for this feature to work. If UAC is off then 
DataNet will not launch on Windows startup.  

 
Map View background 
Use this option to toggle between Stretch and Center views 
for the background image used in Map View. 
 
Set decimal places for… 
For each DataNet sensor, internal or external, you may select 
between 0 and 6 decimal places to be used when displaying 
the data in the software. 
 
Date format 
Choose between four date formats to be used throughout the 
software when displaying data e.g. in the Graph display. 
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Ignore regional settings when exporting to CSV 
Selecting this option will ensure that data will be corrected 
exported to a CSV file and will not use any custom regional 
settings in the Windows OS which might adversely affect the 
layout of the data in the CSV file. 
 
Application data files path 
The default path for saving all data recorded by the data 
loggers is:  
C:\Program Files\Fourier Systems\DataNet\DataNet data files\ 
Click Browse to change this path e.g. to a network path. 
 
Save text data files 
Select this checkbox if you would like DataNet to also save 
the logger data to a text file. This will allow you to export the 
data, in csv format, to another application that can display the 
logger data.  
The default path is: C:\Program Files\Fourier 
Systems\DataNet\DataNet data text files.  
Click Browse to change this path e.g. to a network path. 

Note: The text file cannot be updated with logger data as long 
as it is open. Make sure to close the file when you finish 
inspecting the data, or copy the file to another location and 
view it from there. Alternatively, open the file in Read-only 
mode. 

Path for Report files 
The default path where Report files are stored is: C:\Program 
Files\Fourier Systems\DataNet\Reports. 
Click Browse to change this path e.g. to a network path. 
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Default Paths 
If the user has modified any of the default data file or report 
paths e.g. to a network path, and should this path become 
available for any reason,  then the DataNet application will 
automatically refer to the default path as shown under the 
Default Paths heading.  
This precaution is necessary as otherwise DataNet cannot 
download any data from the data loggers if the data file path is 
not available. Data can therefore be lost.  
 
Enable automatic data download when DataNet is 
launched 
Select this checkbox if you want to have automatic download 
of data when the DataNet software is launched. If there are 
many loggers in the system with fast sampling rates, then the 
download could burden the network. Therefore in some cases 
disabled this feature is advised. 

5.9.2. Email Settings Tab 

DataNet’s alarm notification feature enables sending of Emails 
to notify the user of any alarm in the system. First select the 
Send Email notifications check box. Fill in the fields 
accordingly so that DataNet will be able to send Emails to 
predefined Email contacts when your loggers have breached 
certain alarm levels. 
Make sure to enter the field correctly e.g. with no extra spaces 
or typos. 
Refer to section  5.15.2 for setting Alarm levels on the logger 
and to section  5.16 for managing the Email alarm 
notifications.  

Note: DataNet supports SMTP and MIME encoding, and 
POP3 mail protocols.  
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Figure 46: Options > Email Settings tab 
 

Sending a Test Email  
To send a test Email to verify the Email configuration is 
correct: 
1. Once the Email configuration is complete click Apply to 

enable the Test Email button.  
2. Click Test Email to open the Contact Information dialog. 
3. Select a contact from the DataNet contact list or enter an 

Email address. Click OK to send the test Email.  
4. The test Email will contain the following content: 

Subject: Test message sent from the  
DataNet  software 

Body: This is a test message sent from the 
DataNet software. Sent on the dd/mm/yy  
mm:hh 
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5.9.3. SMS Settings Tab 

DataNet’s alarm notification feature enables sending of SMS’s 
to notify the user of any alarm in the system. First select the 
Send SMS notifications check box. Using the SMS feature 
requires connection of a GSM modem and SIM card to the 
DataNet PC, or even just a cellular phone with an active SIM 
card.  
You must select the COM port which the GSM modem/cellular 
phone is connected to in order for the software to detect it. 

Note: When using a cellular phone as a modem, ensure that 
the PC software suite is disabled before connecting the phone 
to the PC com port. Otherwise the com port will not be 
available for the DataNet software.  

Once the configuration is complete, DataNet will be able to 
send SMS’s to predefined SMS contacts when your loggers 
have breached certain alarm levels. 
Refer to section  5.15.2 for setting Alarm levels on the logger 
and to section  5.16 for managing the SMS alarm notifications.  
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Figure 47: Options > SMS Settings tab 
 

Note: Once the GSM modem is online you will see the green 

GSM icon  appear in the DataNet upper toolbar. 

 

Sending a Test SMS 
To send a test SMS to verify the SMS configuration is correct: 
1. Once the SMS configuration is complete and the GSM 

modem has been detected by the software, the Test SMS 
button will be enabled.  

2. Click Test SMS to open the Contact Information dialog. 
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3. Select a contact from the DataNet contact list or enter a 
telephone number. Click OK to send the test SMS.  

4. The test Email will contain the following content: 
Subject: Test message sent from the  
DataNet  software 

Body: This is a test message sent from the 
DataNet software. Sent on the dd/mm/yy  
mm:hh 

5.9.4. Email/SMS Reception Alarm 
Delay 

To prevent alarm notifications being sent unnecessarily for 
unit’s which momentarily get disconnected from the network, 
the user can define an alarm delay for Email and SMS 
notifications. The RF environment as well as the network 
behavior are very dynamic and can result in very brief 
instances of units going offline. 
• This feature is found on the Email and SMS Settings tab 

in Tool > Options.  
• The alarm delay can be defined from between one minute 

to 24 hours, with a resolution of one minute. 
• If the DataNet software is shutdown during a period when 

alarm delay is being timed i.e. after a unit has gone 
offline, then the time stamp when the unit went offline will 
be recorded. When the software is reopened if the period 
of the alarm delay has already passed then an Email/SMS 
notification will be sent.  
If the alarm delay period has not passed then the 
SMS/Email message will be initiated only if the time delay 
is reached. 
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5.9.5. Analysis Menu Items 

The Analysis menu items are enabled when viewing offline 
data in History View. 
The Analysis options available are: 
• Functions Parameters 
• Dew Point 
• FO Pasteurization 
• Histogram 
• MKT  
• Export to Excel 
• Export to CSV 

 

MKT (Mean Kinetic Temperature) 
Mean Kinetic Temperature or MKT is used for calculating 
temperature stress of perishable stock goods such as 
medicines or food, during storage and distribution cycles. The 
MKT is calculated on a temperature graph opened from an 
offline DataNet data file, in History View. 
 
To use the MKT feature: 
1. Go to File > Open and open the data file containing the 

relevant temperature measurements. 
2. In History View, with the graph tab in view, go to Analysis 

> MKT in the main menu. The MKT dialog is opened. 
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Figure 48: MKT dialog 

3. Use the cursors to select the data set, or leave the graph 
as is to perform the MKT calculation on the entire data 
set. 

4. Enter the relevant Activation Energy, and the Low and 
High Limits of the data set to be calculated (in °C), into 
the MKT dialog.  

5. Click Calculate. A Pass or Fail indication will be displayed 
and in the event of a Pass, the MKT value will also be 
displayed. 

6. Click Print to print the MKT dialog with the results. 
  

Export to Excel 
You may export offline data to Excel by selecting this menu 

item or by clicking the Export to Excel icon  in the lower 
graph toolbar in History View. The data is opened in an Excel 
worksheet and includes pertinent information such as logger 
name, SN, sensor names, alarm levels as well as the actual 
data readings. 
Refer to section  5.20 for more information. 
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Export to CSV 
You may export offline data to CSV file format by selecting 
this menu item. Upon selecting this option, you will be 
prompted to save the file either in the default DataNet 
directory or in directory of your choosing. The data is opened 
in CSV file format and includes pertinent information such as 
logger name, SN, sensor names, alarm levels as well as the 
actual data readings. 
Refer to section  5.20 for more information. 

5.10. Data Recovery 

The ability to recover data when part of the system goes 
offline or is shutdown is a key feature of the DataNet system.  

Note: USB-enabled data loggers support data download via 
USB if wireless transfer is not possible. 

When the data loggers are acquiring data they transmit to the 
Receiver at the predefined rate, either directly or via one or 
more Repeaters.  
There may be occasions when the data transmission fails and 
the data is not updated in real-time in the software window. 
When this happens, the software has several ways of 
recovering the data so the user will always be able to view all 
samples recorded by the logger. The online system will never 
lose data i.e. the data integrity will always been maintained.  
If the end unit tries to send data to the Receiver but fails, it will 
continually try to send the data until it succeeds. In such a 
case, the software or workstation may be shutdown or its 
parent unit, the Repeater, may be offline. Or the end unit itself 
may go offline due to a drained battery. Once the end unit has 
reconnected with the network, for instance when the software 
is reopened or the Repeater is back online, it will be able to 
complete the transmission of all its data and the software will 
be updated with this data. The data recovery is all completed 
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automatically and the user is not required to perform any 
specific actions. 

Note: In the Tools > Option menu, select the checkbox to 
enable automatic data download when the software is 
launched. Otherwise you will have to perform manual 
download from the Logger context menu. 

5.11. Saving Data 

As soon as a logger starts to record data the software creates 
a data file to which it writes the logger data. 
Logger data files are stored in the following default location: 
C:\Program Files\Fourier Systems\DataNet\DataNet data files 
 
A folder is created for each data logger and is named 
according to the logger Serial Number. In this folder is stored 
the data files. A file is created for each day that the logger is 
recording data. The file name format is the date followed by 
the file extension e.g. 2007-12-30.dat.  
 
The data is saved automatically by the software. There is no 
need for the user to save the data manually. The data is 
saved to the data file as follows: 
• Every 15 minutes 
• When the software is closed 
• When the user opens an archived data file, the file is 

updated with all data not saved to that point 
 
You can also save the data in a text file format. Refer to 
section  5.9.1 for more details. 
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5.12. Viewing Archived (Offline) 
Data  

The user can view the logger data online or can choose to 
open archived data. Archived data is all data that was logged 
by a specific logger and recorded by the software into the 
DataNet directory on the PC.  
Follow the instructions below to open archived data. 
1. Click the Open icon to launch the Open Data Files 

dialog. 
2. Select the logger from the list of loggers in the dialog. The 

loggers can be listed in ascending or descending order 
according to logger serial number or comment by clicking 
the relevant header.  

3. Using the calendar define the date and time period for 
which you wish to view your data and click OK. 

Note: The DataNet data file path is displayed at the top of the 
Open Data Files dialog. 
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Figure 49: Open Data Files dialog 

 
4. In the Sync Data dialog, you can select the sampling rate 

at which you wish to display the data. The default option 
is the original rate. Click OK. 
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Figure 50: Sync Data dialog 

 
The data is opened in History View. Refer to section  5.4.3 for 
an explanation of the History View.  
You may display data sets from more than one logger and 
display them all in History View, using the Data Map to 
navigate through the data. Refer to section  5.4.4 for more 
details regarding the Data Map. 

5.13. Viewing Online Data 

You can view the data from any of your network loggers in 
real-time, as the data is being recorded and transmitted to the 
PC: 
• While the logger is running double click the Logger icon 

 in the Map View. 
• While the logger is running open the logger context menu 

and select Display Data. 
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Figure 51: Online data window 
 
The data displayed in this window is the data that was 
transmitted by the logger in the current software session. Data 
transmitted during a previous session of the software being 
open will not be displayed. For example, when you setup the 
logger it creates a new online session. This data can be 
viewed by opening archived data. Refer to section  5.12. 
You may view the data in a graph or table by clicking the 
relevant tabs in the online data window. While in either or 
these views, the data is constantly being updated in real-time 
in the respective view according to the transmission rate of 
the logger. 

Note: Users of Windows 7 using right to left language settings 
e.g. Hebrew, may have problems viewing the Date/Time in the 
DataNet graph. This is a know Microsoft ® bug. Until a bug fix 
is released, change the Regional Settings to English. 
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5.13.1. Showing/Hiding the Data Sets 

In the online graph display, where you have data from only 
one logger displayed, you can show or hide the individual 
sensor data by using the sensor labels at the bottom of the 
graph. 

 
 
In the screenshot above you can see two labels, Internal 
Digital Temperature and Int RH. At present, each label is 
active meaning the sensor data corresponding to the label is 
shown on the graph. 
By clicking any of the sensor labels, you can hide the data 
from the graph. The label will then be grayed out. See the 
screenshot below: 
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Note: You can hide all of the sensor labels (not plots) from the 

graph by clicking the Plot Legend icon . 

5.14. Working in Map View 

The Map View is the main view from which you monitor your 
online network. It is in this view that you can see all the icons 
representing the units in your system, the Receiver, loggers 
and Repeaters too, if relevant.  
Refer to section  5.4.1 for a quick overview of the Map View 
and section  5.4.5 for a list of all the Map View icons. 

5.14.1. Loading Map View Wallpaper 

You can load an image file representing a map of your facility 
in which the network is operating. You can then move the unit 
icons into their actual positions on the map. 
• Double-click on the Map View background to go straight 

into the Open dialog and locate the image file. 
• Right-click on the Map View background to open the 

context menu and select the option to either Load or 
Reset the wallpaper. 

Note: When deploying the system for the first time it is highly 
recommended to use a map of the facility to make the 
deployment work efficiently. 

5.14.2. Printing the Map View 

To print the Map View go to File > Print Map View. This will 
also print the icon name tags and network paths, if enabled.  
The Map View maintains its aspect ratio when printed. 
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5.14.3. Displaying Icon Name Tags 

You can display a name tag for each Logger or Repeater icon 
on the Map View. The name tag consists of the unit 

Comment, as defined in the unit Setup:   
To toggle this feature, right-click on the Map View background 
and select Display All Units' Name. 
When this feature is enabled, clicking the unit icon will also 
highlight the name tag in red. 

5.14.4. Moving Icons around the 
Screen 

Go to Tools > Lock Map View and ensure this menu item is 
not selected in order to freely move the unit icons around the 
screen. When you have finished placing the icons into 
position you may then lock the Map View so as not to 
mistakenly place an icon out of position. 

5.14.5. Logger Icon Context Menu – 
Wireless Connection Options 

Right clicking the Logger icon will give the following options: 

Display Data 
Displays the logger’s data in Graph view. The graph displays 
the data in real-time. There is also the option to display the 
data in Table view or to view the data statistics. 
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Download Data 
Downloads all data in the logger memory to the DataNet 
software. When logger is downloading the data, the Logger 
icon in Map View will appear as follows: 

 
Note: Data download is also available via USB connection. 
Refer to section  5.14.6. 

  

Cancel Download 
When logger is downloading data you may cancel the 
download per logger by selecting this menu item. 
As cancelling the data download results in data not being 
downloaded to the computer, there is a chance that data may 
be lost if the download isn’t completed at a later stage and the 
logger’s cyclic memory has meanwhile erased these readings.  

Note: Cancel Download feature works only if there are no 
other commands in the queue following the Download 
process. For example, if the data is downloading and you sent 
the command Call Unit to the logger, and then selected 
Cancel Download, the download will not be cancelled.   

 

Reset Alarm 
When the logger is in a state of alarm, this option will reset the 
alarm state to normal on both the logger and the software. 
The visual and audible alarms will return to normal. If after 
reset the logger is still in alarm conditions, then the visible and 
audible alarms will return. 
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Call Unit (Beep) 
This feature sends a command to the logger to emit 
intermittent audible beeps for up to one minute. This is useful 
when trying to physically locate a logger in your facility. 
Press the Menu button on the logger to stop the audible 
alarm. 
 

Calibration 
Refer to section  5.17.4 on page 181 for an overview of the 
Calibration feature. 

Note: A logger can’t be calibrated while it is in Run mode. 
The option will be grayed out. You must Stop the logger first. 

 

Update Firmware 
Refer to section  6.2 on page 214 for an overview of the 
Update Firmware feature. 
  

Leave Network 
Selecting this feature will kick the logger off the network. The 
logger will reset and will start scanning for a new network to 
join.  
You will be prompted to enter a password when selecting this 
feature.  

Note: The default password is 1234. 

 

Setup  
Refer to section  5.15 on page 167 for an overview of how to 
setup the logger. 
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Multi-Setup  
By using multi-setup you can select more than one logger on 
the Map View and send the same configuration to all of the 
loggers. When this option is selected, a dialog will open listing 
all of the loggers in the multi-setup selection. 
 

Stop 
Sends a command to the logger to stop logging data. 
 

Multi-Stop 
Sends a command to multiple loggers to stop logging data. 
 

Run 
Sends a command to the logger to start logging data. This 
command will also clear the existing logger memory. 

 

Multi-Run 
Sends a command to multiple loggers to start logging data. 
This command will also clear the existing logger memory. 
 

Show Network Path 
Displays the path of the logger RF data transmission to the 
Receiver. The Transmission Strength legend appears in the 
bottom right of the screen when this feature is enabled. Refer 
to section  5.6.6 for more details. 
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Enable/Disable Short Range Repeater 
Changes the unit between Logger mode and Short Range 
Repeater (SRR) mode, whereby the logger operates as both a 
logger and Repeater.  

Note: In SRR mode the logger must be connected to AC 
power at all times as the power consumption is much greater. 

The logger tooltip and logger LCD menu will both indicate that 
the unit is in SRR mode.  
 

Remove 
This option removes from the Map View any icons of loggers 
that are not on the network anymore and so are irrelevant.  
 

Turn Off 
This option will turn the unit off and is password enabled. As a 
precaution to avoid any data loss all data not yet transmitted 
will first be downloaded to the computer prior to turning the 
unit off. 

5.14.6. Logger Icon Context Menu – 
USB Connection Options 

When connected to the computer via mini-USB cable, the 
DNL910, DNL920 and PA models supports the following 
features: 
• Data Download – Downloads logger memory directly to 

the DataNet data files folder. To view the data refer to 
section  5.12. 

• Firmware Update – Refer to section  6.2.4 for more details. 
• Turn Off – Turns off the unit. 
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To detect the logger using USB: 
1. Make sure the data logger is joined to an existing 

network. When connected to the computer via USB go to 
Network > Detect Logger/Repeater in the DataNet main 
menu. 

2. Right-click on the logger USB icon  to open the 
context menu and select one of the relevant options. 

 

5.14.7.  Viewing Logger Status  

When you scroll the mouse cursor over the Logger icon a 
tooltip will pop up displaying data relevant to the Logger status 
at the time. 
 

Logger Tooltip 
The tooltip will always display the following data, even if 
offline: 
• Serial Number 
• Logger Name/Comment 
 
When the logger is online and running the following tooltip is 
displayed: 
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In online mode, the logger also displays:  
• Device mode – Logger or Short Range Repeater 
• The power status (% Battery left or Connected to AC) 
• Reception quality: Strength of RF signal between logger 

and Receiver 
• Version number: Firmware version of the logger 
• Last sample time: If logger is running, time stamp of last 

recorded sample.  
• Real-time Sensor values: All sensor values are displayed, 

including sensor name and alarm status. 
 

Command Queue Progress 
The tooltip is updated with specific commands being 
performed by the logger. For example, if the logger is 
downloading data to the software you can see the progress in 
the tooltip. In addition, the Logger icon has a blue progress 
indicator so you can monitor the progress without using the 
tooltip.  
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Common commands include Download, Setup, Stop, Run, 
Beep and more. 

5.14.8.  Receiver Icon Context Menu 

Right clicking the Receiver icon will give the following options: 
• Update Firmware 
• Lock Network 
• Form New Network 
• Refresh Network Connections 
• Show Network Path 

 
Update Firmware 
Selecting this option will launch the Receiver firmware update 
process. Refer to section  6.2 for more details. 
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Refer to section  5.6 on page 130 for more details regarding 
the other Receiver options listed above.  

5.14.9. Viewing Receiver Status  

When you scroll the mouse cursor over the Receiver icon a 
tooltip will pop up displaying data relevant to the Receiver 
status at the time. 
 

Receiver Tooltip 
The tooltip will always display the following data, even if 
offline: 
• Unit type (Receiver)  
 
When the Receiver is online the following tooltip is displayed: 

 
In online mode, the Receiver also displays:  
• Serial Number 
• Network: The Network ID of the currently formed network 
• Version: Firmware version of Receiver 

5.14.10. Repeater Icon Context Menu 

Right clicking the Repeater icon will give the following options: 
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Setup  
Repeater Setup lets the user change the name of the unit. 
Once the name has been changed, click Setup (or Close to 
close the dialog without making any changes). 
 

Multi-Setup  
By using multi-setup you can select more than one Repeater 
on the Map View and send the same configuration to all of the 
Repeaters. 
  

Call Unit (Beep) 
This feature sends a command to the Repeater to emit 
intermittent audible beeps for up to one minute. This is useful 
when trying to physically locate a logger in your facility. 
Press the Menu button on the Repeater to stop the audible 
alarm. 
 

Leave Network 
Selecting this feature will kick the Repeater off the network.  
You will be prompted to enter a password when selecting this 
feature.  

Note: The default password is 1234.  

 

Update Firmware 
Selecting this option will launch the Repeater firmware update 
process. Refer to section  6.2 for more details. 
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Show Network Path 
Displays the path of the Repeater RF data transmission to the 
Receiver. The Transmission Strength legend appears in the 
bottom right of the screen when this feature is enabled. Refer 
to section  5.6.6 for more details. 
 

Remove 
This option removes from the Map View any Repeater icons 
that are not on the network anymore and so are irrelevant.  

5.14.11.  Viewing Repeater Status  

When you scroll the mouse cursor over the Repeater icon a 
tooltip will pop up displaying data relevant to the Repeater 
status at the time. 

Repeater Tooltip 
The tooltip will always display the following data, even if 
offline: 
• Unit type (Router)  
• Serial Number 
• Repeater Name/Comment 
 
When the Repeater is online the following tooltip is displayed: 
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In online mode, the Repeater also displays:  
• The Power status (% battery left or Connected to AC) 
• Reception quality: Strength of RF signal between logger 

and Receiver 
• Version: Firmware version of Repeater 

5.15. Configuring the Logger 

DataNet software allows you to configure each logger in your 
network wirelessly. You do not need to have the loggers near 
your workstation, other than for the initial setup when you 
need to connect the sensors (if you’re using external sensors).  
You can also refer to section  3.6 on how to configure the 
logger. 
To configure the logger once it’s online on the network, right-
click the Logger icon in the Map View and select Setup. 
You have two tabs, Device Setup tab and Alarm Setup. 
The main logger configuration is performed on the Device 
Setup tab. Any alarm levels you wish to configure is 
performed on the Alarm Setup tab. 
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5.15.1. Device Setup Tab 

Comment 
This is the name of the logger. It is advisable to name the 
logger according to the location in the facility. 

Note: The Comment field in the software and on the logger 
display supports all standard alphanumeric characters except 
for the following: ', ", ~, &, \  

 

Sampling Rate 
Sampling rate is one sample per second to one sample per 18 
hours. However, there are programming limitations you must 
be aware of when configuring the loggers. The sampling rate 
will vary depending on the number and type of sensors you 
setup. Refer to section  4.7.5 on page 57. 
 

Transmission Interval 
You can define how often the logger will actually transmit to 
the network. You may wish to have the logger transmit with 
every sample, if you have slower sampling rates, or less 
frequently, if you have a fast sampling rate. 
The transmission interval must be a multiple of the sampling 
rate, so for example if the sampling rate is 3 seconds, then the 
minimum transmission rate must be every 3 seconds, and 
then every 6 seconds, 9 seconds, and so on. 
This parameter was designed to ease the burden on the 
network if you have many loggers as each logger can transmit 
at different rates. 
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Averaging Points 
You can choose have online averaging of up to 10 points 
around the real value in order to smooth the data readings, if 
they are a little noisy. The recommended averaging is 4 
samples. 
 

Temperature Units  
Toggle between °C and °F. This applies to the readings 
displayed on the logger LCD as well as in the software.   
 

Active Sensors  
Depending on the logger model, you can activate up to two 
internal sensors and four external sensors. Simply select the 
inputs you want to use and then select the sensor types from 
the adjacent drop-down menu. You don’t have to select the 
external sensor input in any order. You may select only Input 
4 if you desire. 

Note: On the DNL920 you cannot run the humidity sensor 
without running the temperature sensor in parallel. 
This is because when using the DNL920 data logger and 
selecting the internal humidity sensor in the Device Setup 
dialog, the internal digital temperature sensor will 
automatically be selected as well. This sensor provides the 
temperature compensation necessary for the humidity sensor 
to reach the 3% accuracy as stated in the sensor 
specifications. It is not used for recording temperature. The 
internal digital sensor is used to record temperature on the 
DNL920. 

 

Custom Sensor Names  
You can also give the sensor a custom name, which will 
appear in the software when viewing the data. This is 
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convenient when using several of the same type of sensors 
and you wish to differentiate between them in terms of their 
environment or material it is measuring. 
 

Recording Time 
This field displays the length of time the logger memory will be 
able to record for depending upon the number of sensors 
used and sampling rate. 
 

Setup and Run 
Clicking Setup and Run will send the setup to the logger and 
immediately start logging data. 
 

Setup Only 
Clicking Setup Only will send the setup to the logger but it will 
not actually start logging data. You will need to select Run 
from the Logger context menu or go back into the Setup 
dialog.  
 

Close  
Clicking Close will close the Setup dialog without saving any 
of your configurations. 

Note: Running the logger clears the logger memory. All 
previously recorded data will be erased when you begin a new 
logging session. 

5.15.2. Alarm Setup Tab 

A major feature of the DataNet system is the ability to 
configure alarm levels into the loggers so any breach of these 
levels as recorded on the data logger is monitored by the 
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software, and the user is notified via Email/SMS/audible and 
visual indicators. 
 
The Alarm Setup tab lets you configure each sensor for the 
following alarms: 
• Low 
• Pre-Low 
• Pre-High 
• High 
• Contact Open / Contact Close (when the Contact sensor 

is selected) 
 
Using the Pre Alarms gives the user ample warning of a 
possible breach of real alarm levels, so necessary measures 
can be taken to prevent such a breach.  
Simply select the check box for the type of alarm you wish to 
be notified. You can select all alarms too. Enter the alarm 
value in the text box. 
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Figure 52: Alarm Setup tab 
 

Alarm Delay and Pre-alarm Delay 
The time until the alarm (or pre-alarm) is activated. You may 
not want to have the alarm sound immediately after the alarm 
level is breached as you are only interested in a condition 
where the alarm level lasted a certain amount of time. 
For example, if monitoring change of temperature in a freezer, 
you would only be interested in a High alarm which lasted 
more than one minute as anything else could just be caused 
by the freezer door opening for a few seconds, as opposed to 
a power failure leading to rise in temperature.  
 

Alarm Duration 
The duration of the alarm that is set off by one or more 
sensors breaching the alarm level. 
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Sound Alarm during Pre-alarm 
You also have the option to sound the alarm in the software 
during a pre-alarm scenario, not just for a standard alarm. 
 
Once you have configured your alarms, you may return to the 
Device Setup tab or click one of the Setup buttons at the 
bottom of the tab. 

5.16. Entering Alarm Reason 

In the DataNet CFR software, and as part of the CFR 
requirements, any recorded sensor alarm must be assigned 
an explanation why the alarm occurred. 
Whenever an alarm is recorded the Alarm Reason icon will 
flash in the upper DataNet toolbar. It will continue to flash until 
all alarms are assigned a Reason. 
When exiting the application a system message will pop up 
warning that there are alarms without an explanation.   
To add an alarm reason: 
1. Click the Alarm Reason icon to open the Update Alarm 

Reason dialog. 

 
Figure 53: Update Alarm Reason dialog 

2. Select the relevant alarm from the drop-down menu and 
enter the reason in the text box. 
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3. Click OK when finishing entering all alarm reason. The 

Alarm reason icon will now be disabled: . 
4. The alarm reasons will be updated in the DatPass 

database and will appear in the DatPass Audit Trail. 

5.17. Alarm Notifications Setup 

Once you have completed the logger alarm setup in section 
 5.15.2 above, you can now configure DataNet to send alarm 
notifications via Email or SMS.  
From the Tools menu select one of the following options, 
depending on the type of notifications required: 
• Email Alarm Notification 
• SMS Alarm Notification  

Or click the Email  or SMS  icons located in the upper 
toolbar in order to launch the notification dialog. 

Note: To enable sending of Email or SMS first define the 
Email and SMS settings in the Tools > Options dialog. 
Connect a GSM modem to the PC if sending SMS’s. Refer to 
section  5.9 on page 137 for more details. 

 
You may manage your contact list of alarm notification 
recipients from either the Manage Contacts menu item in the 
Tools menu, or from within the Alarm Notification dialog itself. 
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Figure 54: Alarm Notifications Setup dialog 
 
As the Email and SMS Alarm Notifications must be defined 
separately, they each have separate dialogs. However the 
interface is identical and the contacts are stored in the same 
database.  
The Email/SMS Notifications dialog is divided into the 
following tabs: 
• Notifications Setup 
• Contacts tab 
• Groups tab 

5.17.1. Contacts Tab 

The first step is to create the contacts who shall be receiving 
the notifications. The ability to manage contacts is possible 
from both the Email and SMS Notifications dialogs.  
1. Click the Contacts tab and then click Add Contact. 
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Figure 55: Adding a contact 

 
2. In this dialog you must first enter the contact name in the 

Name field. That is the only mandatory field but if you 
don’t enter at least the phone number or Email then they 
won’t receive any alarm notifications. 
The other fields in the dialog are as follows: 
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 Title: Corporate position 
 Phone number: The number the DataNet software 

will use to send the SMS notification. 
 Note: The phone number field supports the following 

characters: 0-9, # , *, -, ( ), +  
 Email: The address the DataNet software will use to 

send the Email notification. 
 Workday Start and End: You can define the hours in 

which the contact will be eligible to receive the 
notifications i.e. so they don’t receive SMS or Email 
while in the office, or vice versa. 

 Vacation: You can define when the contact is on 
vacation so they won’t receive any notifications over 
this period. 

 Number of SMS resends: The number of times 
DataNet will send follow-up SMS’s with the alarm 
notification. The maximum is nine resends per alarm. 
The gap between each resend is five minutes. 

Note: In order to stop receiving SMS resends, you 
can simply send an SMS with ‘OK’ in the message 
body to the GSM SIM card’s phone number.  

3. When the contact details have been entered, click OK. 
4. The contact will be added to the Contacts tab. You may 

choose to add another contact, edit an existing contact or 
remove a contact from the list. 

5.17.2. Groups Tab 

1. Click the Groups tab and then click Add Group. The 
Group Details dialog will open.  
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Figure 56: Adding a group 

 
2. Enter a Group name and add your existing contacts to the 

group by selecting the checkbox next to the Contact 
name. 

3. Click OK to create the Group. In the Groups tab you may 
choose to add a group, edit an existing group or remove a 
group from the list. 

5.17.3. Notifications Setup Tab 

1. Once the contacts have been created you may start 
defining which contacts should receive the alarm 
notifications. 

2. The pane on the left-hand side of the Notifications Setup 
tab displays all the units, loggers or Repeaters and their 
serial numbers, which have been configured in your 
network. You must define the alarm notifications for each 
unit in turn. Select the first unit you wish to define.  
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3. The Email or SMS tab is now active for the unit selected 
in step 1 above. In this tab, select the type of alarm for 
which the notification should be sent in the event that the 
predefined alarm level is breached.  

4. Only the sensors which were configured in the logger 
Setup, with alarms levels, are enabled in this tab. In 
addition, any online Repeater will be enabled for sending 
battery alarm or reception alarm notifications. 

 
Figure 57: SMS and Email notification setup 

 
5. Select the checkboxes according to the type of sensor 

alarm for which notifications should be sent. 
You may also select the following alarms: 
a. Battery alarm: Notification will be sent for low battery 

alarm when battery level is at or drops below 10%. 
When the battery level goes above 10% again, when 
unit is connected to AC power, another email 
notification is sent stating the battery is charging.  
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b. Reception alarm: An Offline alarm notification will be 
sent when there is no RF reception from a unit. When 
the unit is back online, an Online notification is sent. 

c. Normalized: Notification will be sent when the logger 
return to normal levels having been in alarm. 

6. Click the Contact button adjacent to each of the sensors 
which have defined alarms. In the Select Contact dialog, 
select the contact and/or group that will receive the 
notification. 

7. You can also click Check All to select all the sensor 
alarms for notification. 

Note: If the logger transmission rate is slower than the 
sampling rate, an alarm notification is still sent even if the 
logger transmission time hasn’t passed. For example, if 
the sampling rate is every 5 minutes, and the 
transmission rate is every 10 minutes, if a logger reaches 
a high alarm after 7 minutes a notification will be sent. 
The system won’t wait until the scheduled transmission 
time. 



 
 

181 

5.17.4. Email and SMS Notification 
Formats 

Email Notification Format 
When the Email notification is sent the recipient receives the 
Email in the following format: 
 

Email Header:  
DataNet Alarm: Internal Temperature High Alarm, Value 
Detected: 25.47C)  
Email Body: 
DataNet Alarm 
Comment: Factory 1/F  
S/N: 808932 
08-07-09 13:53:41 
Internal Temperature Low Alarm, 
Value Detected: 25.47 C 

 
The Email header contains the sensor type, last recorded 
sample, and alarm type. 
In addition the Email body contains the logger comment, serial 
number, time stamp of last sample and value of last sample. 
 

SMS Notification Format 
When the SMS notification is sent the recipient receives the 
SMS in the following format. (The logger comment is 
displayed in the first row). 
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S/N 515244, Test 810#2, Int. Temperature 15/1/10 17:25 – 
High Alarm, Value Detected: 24.24C 

5.18. Calibration 

The DataNet data loggers are shipped fully calibrated with a 
calibration certificate. However, DataNet does provide a 
simple and efficient process for users wishing to calibrate the 
DataNet data loggers themselves. The process itself can be 
performed wirelessly, over the network, but as with any data 
logger calibration a calibrator or other type of calibration 
instrument is necessary. 
 
The Calibration options are accessible via the Logger context 
menu in the Map View (right-clicking the Logger icon).  
Before performing logger calibration, the logger must be in 
Stop mode. In addition, all of the calibration options are 
accessible with a password making it difficult for non-
authorized users of the system to tamper with the loggers’ 
calibration settings. 

Note: The default password is 1234. The password can be 
changed in the password dialog box. 

 
The Calibration option menu options are: 
• Calibration: Opens the main Calibration dialog 
• Save Calibration: Saves the logger’s current calibration 

settings 
• Load Calibration: Loads a logger’s previously saved 

calibration settings. 
• Reset Calibration: Resets the logger’s calibration 

settings so that the raw hardware data is obtained, 
without any software calibration applied to these values. 
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• Restore Factory Calibration Default: Restores the 
logger’s calibration settings to the factory calibration i.e. 
the calibration settings it received prior to shipment from 
Fourier. 

5.18.1. Introduction to DataNet 
Calibration  

Although the DataNet data loggers come fully calibrated, the 
software enables you to calibrate any of the DataNet sensors, 
on any input. The calibration parameters are sent to the data 
logger and stored in its memory.  

DataNet employs two different calibration methods: Two-
point calibration and Offset calibration. 

Each sensor can be calibrated using the Two-point calibration 
method, and then tweaked using offset calibration, except for 
the Thermocouples. These sensors require offset calibration 
only. 

Sensor Type Calibration 
Method 

Current 4 – 20 mA Two-point 
calibration 

Humidity (Internal) Digital Two-point 
calibration 

Temperature 
(Internal) Digital Two-point 

calibration 

Temperature 
(Internal)  PT-100 

Two-point 
calibration and 
offset 

Temperature PT-100 2-wire 
Two-point 
calibration and 
offset 
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Temperature Thermocouple J Offset calibration 
Temperature Thermocouple K Offset calibration 
Temperature Thermocouple T Offset calibration 

Voltage 0 to 1 V Two-point 
calibration 

Voltage 0 to 50 mV Two-point 
calibration 

 

Calibration Tips 
Prior to any two-point calibration it is recommended to restore 
factory calibration defaults. 
Prior to calibrating any of the thermocouple sensor types, 
calibrate the Voltage 50 mV sensor as this will set the gain 
(slope) of all thermocouple sensor types. 
After calibrating 50 mV, TC-J, TC-K or TC-T sensor types for 
all inputs you can refine the offset calibration for each input 
individually. 
You may calibrate all thermocouple sensor types at once, or 
individually. 
Prior to calibrating the PT-100 input, you must first perform 
Reset Calibration in the Calibration dialog. 

 

Two-point Calibration 
The two-point calibration sets the gain (slope) and offset 
(intercept) of the sensor's conversion function. 
Use the two-point calibration to calibrate all DataNet sensors 
except for the Thermocouples. In some cases you may need 
to refine your calibration using the fine offset tuning tool. 
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Offset Calibration 
To calibrate the Thermocouple temperature sensors: TC-J, 
TC-K and TC-T, first calibrate the 50 mV sensor type. That will 
set the slope for all Thermocouple temperature sensors. Then 
proceed to adjust the offset using the Offset calibration 
technique. 

5.18.2.  Calibrating the Data Logger 

 
Figure 58: Calibration dialog 
 
1. From the Map View, open the Logger context menu and 

select Stop. 
2. Select Calibration > Calibrate and enter the password in 

the Password dialog. 
3. Select the sensor you wish to calibrate from the Sensor 

drop-down menu.  
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4. If calibrating an external sensor, select the inputs to 
calibrate. Select All or an individual input, 1 to 4. 

5. Click Setup to send the sensor setup to the logger.   

Note: The calibration process does not delete the logger’s 
setup prior to calibration. Once Calibration is complete the 
original logger setup will be restored. 

6. If you selected All inputs, then by default the logger will 
be setup to log data on Input 1 during the calibration 
process. Otherwise, if you selected a specific input, it will 
setup the logger to calibrate on that input.  

Logger Data Pane 
The Logger Data pane displays real-time readings on the 
logger, at a default sampling rate of one per second. You can 
also view the logger’s general status. Use the Logger Data 
pane to verify your logger is properly calibrated.  
The Calibration dialog will enable either Two-point or Offset 
calibration, or both, depending on the sensor selected. 

Note: The calibrated sensor parameters will be saved both in 
the DataNet logger and in the software memory, so there is no 
need to calibrate the logger every time you run the software. 

5.18.3. Performing a Two-point 
Calibration 

To perform a two-point calibration, you must have two 
reference points to input against the real logger sensor 
values.  
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Figure 59: Two-point calibration window 
 
1. In the Point #1 field, enter the first Reference Value and 

the corresponding Logger Value.  
2. In the Point #2 field, enter the second Reference Value 

and the corresponding Logger Value.  

Note: If you are using a calibrator and the logger is currently 
displaying the real value to be calibrated, press the Copy 
button to copy the real value to the Logger Value text box. 

3. Press Send Calibration to send these values to the 
logger memory.  

4. Compare the real value in the Logger Data pane to the 
reference value. If the values are within an acceptable 
margin of error you may close the Calibration window, or 
move on to the next sensor or input. 

5. If the values are still not accurate enough, you can 
perform Offset calibration to tweak with values further. 

Note: Fourier strongly recommends calibrating using the 
default Reference values that appear in the two Reference 
value text boxes for each sensor. 
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5.18.4. Performing an Offset 
Calibration 

If, after the Two-point calibration procedure, the logger still 
exhibits some offset value use the Offset calibration tool to 
correct it. 
The offset value is the difference between the value displayed 
by the DataNet logger and the reference value. For example if 
the calibrator is set to 0 °C and the logger reads 1 °C the 
offset value is +1, but if the logger reads −1 °C then the offset 
value is −1.  
 
To perform an Offset calibration, simply select the Offset 
calibration radio button to enable the Offset text box. For 
Thermocouples you will only have the option to perform an 
Offset calibration. 
Enter the offset value in the text box and click Send 
Calibration. Continue to adjust the offset accordingly until 
satisfied with the readings. 

5.18.5. Setting the Offset to a Specific 
Input 

After setting the offset to all inputs simultaneously, you can 
set the offset of each input separately for even better 
accuracy.  
To set the offset of a specific input: 
1. Measure two known reference values making sure to use 

the input you need to calibrate. 
2. Enter the offset value as described in section  5.18.4 

above, making sure to select the correct input number 
instead of All. 
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3. You can repeat the procedure for every input. 

5.18.6. Calibrating the Internal 
Temperature Sensor on the 
DL910 

The DNL910’s internal temperature sensor is a PT-100 
sensor. Calibration of this sensor is performed by calibrating 
the external PT-100 input i.e. two-point calibration followed by 
offset calibration. 
1. In the Calibration dialog, select PT-100 in the Sensor 

drop-down menu and select All inputs.  
2. Press Setup to proceed.  
3. Connect a calibrator or an actual PT-100 sensor to Input-

1. Calibrate the input using the reference values. 
Once this calibration procedure is complete both the logger’s 
internal temperature sensor (PT-100) and external PT-100 
inputs will be calibrated. 

5.18.7. Calibrating the External PT-100 
Sensor Input 

PT-100 calibration is a standard 2-point calibration followed by 
offset calibration. Once the PT-100 sensor has been selected 
in the Sensor drop-down menu, click the Reset Calibration 
button. Then proceed with the 2-point calibration procedure. 
Before each calibration this step must be performed otherwise 
the calibration will not be accurate. 
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5.18.8.  Saving Calibration Settings 

At any time you may manually save the logger’s calibration 
settings locally to your PC.  
1. Open the logger context menu, select Calibration > Save 

Calibration and enter the password to access this 
feature. 

2. The Save As dialog will open. Name the calibration file 
(with extension .dcf) and save it either in the default 
Calibration folder in the DataNet directory or in a folder of 
your choice.  

5.18.9.  Loading Calibration Settings 

You can load a previously saved DataNet .dcf calibration file 
at any time to restore a logger’s restore specific calibration 
settings. 
1. Open the logger context menu, select Calibration > Load 

Calibration and enter the password to access this 
feature. 

2. In the Open dialog, browse to the calibration file you need 
and click Open. The logger will be updated with the new 
calibration settings. 

5.19. Analyzing the Data 

When in offline (History View) or online data displays, you 
have a number of features for analyzing the on-screen data. 
The features for analyzing data while in the graph display are 
practically the same when in offline or online mode. 
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5.19.1.  Using the Graph Features 

The following section explains how to use the numerous 
graph analysis features, including an overview of the graph 
toolbar options. 
Please first refer to section  5.4.5: DataNet Toolbar Icons for a 
full overview of the graph toolbar. 
 

Autoscaling 

Click Autoscale  on the graph toolbar to view the full data 
display, thereby restoring the axis range to its default settings. 
 

Zooming 
To zoom in to a specific area of the graph: 

1. Click Zoom in  on the graph toolbar. 
2. Drag the cursor diagonally to select the area you want to 

magnify. Release the mouse button to zoom in to the 
selected area. 

3. Click Zoom in  a second time to disable the zoom 
tool. 

4. Click Autoscale to restore the default display. 
 

Panning 

Use the Pan tool  to pan along the x or y axis or after 
zooming in, to see any part of the graph that is outside the 
zoomed area. 
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1. Click Pan  on the graph toolbar, then click anywhere 
on the graph and drag the mouse to view another area. 

2. Click the Pan icon a second time to disable the Pan tool. 
 

The Cursor 
You can display up to two cursors on the graph 
simultaneously. 
Use the first cursor to display individual data recording values. 
Use two cursors to display the difference between two 
coordinate values, to display the frequency of periodic data or 
to select a range of data points. 

 
Figure 60: Example of using two cursors 
 
When using two cursors, the Statistics feature will calculate 
statistics according to the data set between the two cursors. 
To display the first cursor: 

Click 1st Cursor  on the graph toolbar. You can drag the 
cursor with the mouse onto any other point on the plot, or onto 



 
 

193 

a different plot. For finer cursor movements use the forward 
and backward keys on the keyboard.  
The coordinate values of the selected point will appear in the 
information bar at the bottom of the graph window. 
 
To display the second cursor: 

Click 2nd Cursor  and drag the cursor with the mouse onto 
any other point on the plot. The information bar will now 
display the difference between the two coordinate values. 
 
To remove the cursors: 
Click the cursor icons a second time. 
 

Grid 

Click the Grid icon  to add a grid to the background of the 
graph view. To remove the grid, click the icon again. 

 
Figure 61: Graph with grid in background 
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Add Custom View 
Whenever the graph in History View is modified, either by 
using the Zoom tool, changing the scale, panning the graph, 
etc. you have the option to add this customer graph view to 
the Data Map, under the Custom Views node. This will enable 
you to save projects which include the custom graph view for 
future reference. 

Click the Add Custom View icon  to perform this function. 
 

Copying the Graph 

Click the Copy Graph icon  to copy the graph to the 
clipboard, and paste it into another application, such as a 
word processing or spreadsheet application. 
 

Displaying Alarm Levels 
Open the Alarm drop-down menu and select the relevant 
sensor to display its alarm levels.  

 
 

The Stretch/Compress Axis Tool 
Move the cursor onto one of the graph axes. The cursor icon 
changes to the double arrow symbol (↔), indicating that you 
can stretch or compress the axis scale. Drag the cursor to the 
desired location. Repeat the procedure for the other axis if 
necessary. 
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To select a data set to display on the Y-axis, click on the data 
set’s name in the Y-axis list. To display more than one curve, 
click on the data sets you want. 
 

Formatting the Graph  
You can change the plot line’s color and width. The color of 
the Y-axis matches the corresponding plot’s color and will 
automatically change with any change made to the color of 
the corresponding plot.  

1. Click Graph properties  on the graph toolbar. 
2. Click the Style tab, and unselect the Use system line 

properties checkbox.  
3. Select the axis you want to format in the Axis drop-down 

menu. 
4. Select the color and line width.  
5. Click OK. 
6. To restore the default formatting, select the Use system 

line properties checkbox again.  

 

Manual Scaling 

1. Click Graph properties  on the graph toolbar. 
2. Select the Axis Scaling tab and with the Group plots by 

units checkbox unselected, select the axis to manually 
scale from the drop-down menu e.g. Date & Time axis.  

3. Uncheck the Autoscale check box and enter the custom 
values in the text box i.e. a time range, in the case of the 
Time & Date axis, or a set of values. 

4. Click OK. 
5. To restore auto scaling select the Autoscale checkbox.  
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Manual Scaling - Grouping Plots by Unit 
You may choose to group all of the sensors measuring the 
same unit, to the same scale. For example, if you have 
several temperature sensors in your data set, all measuring 
Celsius, you can apply a common scale when displaying the 
data from these sensors. 

1. Click Graph properties  on the graph toolbar. 
2. Select the Axis Scaling tab and select the Group plots 

by units checkbox. 
3. In the Axis drop-down menu select the unit by which you 

wish to group the plots.  
4. Uncheck the Autoscale check box and enter the custom 

values in the text box.  
5. Click OK. 
6. To restore auto scaling select the Autoscale checkbox.  

 
Figure 62: Grouping plots by units 
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5.19.2. Changing the Graph, Table or 
Statistics View Header 

Each Graph, Table or Statistics tab has a header located 
above the specific view. The default headers are: 
• DataNet - Graph 
• DataNet - Table 
• DataNet - Statistics    
The header will also be included when printing the graph.  
To change the header: 

1. Click Graph Properties  on the graph toolbar. 
2. Click the Style tab and enter the graph header in the 

Header field.  

5.19.3. Statistical Analysis 

DataNet also provides some basis statistics regarding the 
open data sets. While in History View or online Data Display 
view, click the Statistics tab.  
For each of the sensors in the data set, you will have the 
following statistics displayed: 
• Minimum / Maximum values 
• Average value 
• Number of samples 
You will also see the Logger name and SN, as well as the 
start and end time of the statistics data range. 
While in online mode these statistics are updated in real-time. 



 
 

198 

If you zoom onto a section of the graph, the statistics are 
dynamic and will therefore display statistics of the zoomed 
graph, not of the whole graph.  
If using the cursors, the statistics will be calculated according 
to the data set between the two cursors. 
 

 
Figure 63: Statistics View 

5.20. Exporting Data to Excel or 
CSV Formats 

DataNet supports exporting data to Excel or CSV file formats 
(CSV stands for comma separated values).  

To export to Excel, click Export to Excel  in the online or 
offline lower graph toolbar, or go to Analysis > Export to 
Excel (while viewing data in History View). The data currently 
displayed on the graph is exported. Data from more than one 
data logger may be exported simultaneously.  
DataNet will then open a new Excel workbook displaying the 
data as well as other pertinent information such as logger 
comment, serial number and the alarm level setup. Data that 
exceeds any of the alarm levels will be indicated. 
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Figure 64: Example of data exported to Excel 
 
Only offline data opened in History View can be exported to 
CSV and is available under the Analysis menu.  

5.21. Printing the Data 

You are able to print data by clicking the Print icon  from 
the lower toolbar in Graph, Table or Statistics tabs of the 
offline or online data displays. Clicking the Print icon will open 
the Print Setup dialog where you will need to select the 
printer to print to. 
When printing a table, you can select the specific data range 
you wish to print. You are able to adjust the date and time in 
order to narrow the data range. 
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Figure 65: Printing a table 

5.22. Reports Module 

The Reports module provides the DataNet CFR user with an 
intuitive interface for creating and generating DataNet reports 
containing a wide range of parameters garnered from the 
DataNet units and software. Each report can be sent via e-
mail to a selected distribution list for Review and Approval, at 
pre-defined time intervals, in PDF and Excel format. 
 
All reports are saved in the default directory:  
C:\Program Files\Fourier Systems\DataNet\Reports 
To change this path go to the Preferences tab in Tools > 
Options.  

5.22.1. Creating a Report Profile 

The first step when creating a report is to create a new Report 
Profile. The user can create multiple profiles, each configured 
with different parameters. To generate a report, at least one 
profile must be enabled. 
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1. Go to Reports > Reports Profile Manager in the main 

menu, or click the corresponding icon  in the upper 
toolbar. 

2. Enter the system password. The Reports Profile Manager 
window will open.  

3. Click Create New Profile. 
4. Select the Enable Report Profile checkbox to enable all 

fields in the window. Each profile that is enabled will have 
a report generated. If no profiles are enabled, DataNet will 
not generate any reports. 

 
Figure 66: Reports Profile Manager window 
 

5. Enter a suitable profile name in the Profile Name field. 
6. Enter your name in the Report Generated By field. 
7. Enter a description of the report in the Report Comment 

field. 
8. Each report created in PDF format contains a header. To 

change the report’s header, select the PDF Header 
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Image checkbox and click Browse to locate the relevant 
image. The default Fourier header is: 

 
Note: The recommended header dimensions are 525 x 50 
pixels, 72 dpi. If a header with different dimensions is loaded, 
then the software will automatically resize the header 
dimensions. 

9. Toggle the temperature unit to appear on the report, if any 
of the logger’s are configured to measure temperature. 

10. Next to Report Format, select the checkbox next to the 
required format in which to generate the report. Excel, 
PDF or both formats. For PDF format, select the page 
size, A4 or Letter, from the drop-down menu. 

11. Click the Generated Report checkbox to send the report 
via email to a selected distribution list. Click Contacts to 
open your contact list and select the relevant contacts to 
receive the report via e-mail. If your contact list is empty 
then the Select Contacts window will automatically open 
when first clicking Generated Report. 

 
Note: To send reports via e-mail, ensure the DataNet e-mail 
settings are correctly configured in Tools > Options > e-mail 
Settings. 

12. DataNet CFR provides the ability to send reports for 
Review and Approval by users with specific privileges to 
review and/or approve reports generated by the software. 
Select Reviewed Report and/or Approved Report and 
select the required contacts from the Contacts dialog. 
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Recipients of these reports will be able to enter the 
DataNet CFR using their assigned username and in the 
Reports Browser, declare the report was reviewed or 
approved. Refer to section  5.22.4 for more details. 

13. In the Report Type pane, select at least one of the report 
type checkboxes. You will not be able to save the profile 
unless a report type has been selected. 
The available types are below. For more details regarding 
each type, refer to section  5.22.2: 

 Alarm Log 
 Events Log 
 Unit Setup Log 
 Unit Statistics 
 Sent Email Log 
 Sent SMS Log 
 Received SMS Log 
 Sensors Graph 
 Sensor Histogram 

14. Once a Report Type has been selected, immediately click 
Save Profile to avoid losing your unsaved profile. 

15. Use the Report Time pane to select the interval when the 
report will be generated and emailed to the contact list (if 
desired): 
a. Next to Generate Report at select the time when the 

report should be generated.  

Note: To allow for data samples recorded in the last 
minute prior to the defined time, the report will actually be 
generated 10 minutes after the defined time.  

b. Select the date when the report should be generated. 
The options are daily, weekly or monthly. Select the 
specific day for the latter two options. 
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c. The user can also select a report according to a 
specific time period. Select the User Defined option, 
choose the period and click Generate to manually 
generate the report according to the defined 
parameters. 

16. Use the Units pane to select which loggers should be 
included on the report itself.  
a. Select the All Units checkbox to include all network 

units.  
b. To include a specific selection of units, unselect the 

All Units checkbox and manually select the checkbox 
for each unit.  

c. The order in which the units will appear on the report 
can be defined according to Serial Number by 
selecting By S/N and clicking the S/N header or 
manually, by selecting Manual and clicking the Up 
and Down arrows. 

The definition of the report is now complete. Click Save 
Profile and then Close to exit the Reports Profiles 
Manager. A report will be generated at the defined time. 

5.22.2. Report Types 

Each report contains at least one Report Type, with the data 
displayed in table format. A description of each Report Type 
parameter in the Reports Profile Manager is provided below. 
 

Alarm Log 
• Parameters include sensor name, setup, alarm 

parameters, and setup time. In addition, each sensor 
alarm value is listed according to the relevant setup. If 
there are other setups in the report time frame then 
additional setup tables and alarm tables will be displayed. 
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• Battery and Reception alarms will be listed after the 
sensor alarms. 

• If no alarms were recorded during the report time frame, a 
No Alarm Events message will be displayed. 

 

Events Log 
Logs all events of each logger in the Report, as well as the 
time of the event. The events are: 
• Setup 
• Run 
• Stop 
• Connection to network 
• Disconnection from network 
• Firmware updated, including indication of previous and 

updated firmware version  
• Leave Network 
 

Unit Setup Log 
• Logs all the setups of the logger during the logging period 
• If no setups were performed during the report time frame 

the a No New Setup message will be displayed 
 

Unit Statistics 
Displays statistics for each sensor in the report. The 
calculated parameters are: 
• Min 
• Max 
• Average 
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• Number of samples 
 

Sent Email Log 
Logs all emails that were sent during the report time frame. 
The details in the Sent Emails Log are: 
• Message that was sent 
• Date 
• Time 
• To whom the message was sent (groups will be displayed 

as groups) 

 

Sent SMS Log 
Logs all SMS’s that were sent during the report time frame. 
The details in the Sent SMS Log are: 
• Message that was sent 
• Date 
• Time 
• To whom the message was sent (groups will be displayed 

as groups) 

 

Received SMS Log 
Logs all SMS’s that were sent to the DataNet software during 
the report time frame. 
The details in the Received SMS Log are: 
• Message that was received 
• Date 
• Time 
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• From whom the message was sent  

 

Sensor Graph 
The Sensor Graph log includes the following parameters: 
• Unit comment and S/N indicated as the graph header 
• Indication of sensor name, sensor type, start time & date 

and end time & date under each graph 
• A small graph of each sensor that is defined in the logger 

with its alarm levels displayed according to the alarm 
colors. The graph will be created according to the last 
logger setup. 

• The graph scaling will be set to autoscale 
• The graph will include grid lines 
• The alarm levels will be marked according to the alarm 

color and the alarm limit value will be indicated on the Y- 
axis 

• The graph dimensions will be 7.5 cm x 10.5 cm 

 

Sensor Histogram 
• Unit comment and S/N indicated as the graph header 
• Under each Histogram there will be indication of the 

sensor name, sensor type, start time & date and end time 
& date 

• A small histogram of each sensor defined in the logger 
will be displayed 

• The histogram will include an indication of the value of 
each bin on top of the bin 

• The graph dimensions will be 7.5 cm x 10.5 cm 



 
 

208 

5.22.3. Removing a Report Profile 

To remove an existing report profile:  
1. Go to Reports > Reports Profile Manager in the main 

menu, or click the corresponding icon  in the upper 
toolbar. 

2. In the Profile list on the left side of the window, right-click 
the Report name to be removed and select Remove from 
the context menu. 

3. Enter the system password and when prompted, confirm 
the action. 

5.22.4. The Report Browser 

Use the Report Browser to:  
• Open or delete generated reports saved in the Reports 

folder in the default DataNet directory.  
• Assign a Reviewed By or Approved By stamp on each 

report, based on the user’s privilege as defined in 
DatPass. 

Reports are displayed per Profile. 
 
1. Go to Reports > Report Browser in the main menu, or 

click the corresponding icon  in the upper toolbar. The 
Report Browser window will open. 

2. Select one of the profiles in the Profiles pane on the left 
side of the window. All reports generated under that 
profile will appear in the main Report pane. 
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3. Use the Excel, PDF, Reviewed and Approved 
checkboxes to filter the reports to be displayed in the 
Report pane.  

 
4. To open a report click one of the reports in the list and 

click Open. 
5. To sign the PDF report (Excel reports cannot be signed), 

select the specific report. The Review and Approve 
buttons are enabled.  

6. Depending on the user’s assigned privileges, click 
Review or Approve. The following dialog will pop up. 
Enter a Comment relating to the read report. 

 
7. Click OK. An updated report contained the user’s relevant 

report sign-off, (Reviewed or Approved) will be emailed to 
the user who generated the report. 

8. To delete a report click one of the reports in the list and 
click Delete. 

9. Click Close to close the Reports Browser window. 
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5.23. System Password 

Throughout the software you will be required to enter a 
password to perform certain functions such as calibration or 
firmware update.  

Note: The default password is 1234. 

 
To change the password: 
1. In the Password dialog box, click Change Password to 

open the Change Password dialog box. 
2. Enter the current password in the Current Password text 

box. 
3. Enter the new password in the New Password text box. 
4. Enter the new password a second time in the Confirm 

New Password text box to confirm your new password. 
5. Click OK. 

Note: The password must include at least 4 characters and is 
case sensitive. 
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Chapter 6:  
Updating DataNet 
Software and Firmware 

DataNet v2.0 supports automatic software and firmware 
update whenever DataNet is launched, as long as the 
computer is connected to the Internet. The update process is 
managed by Fourier’s Uptodata client. This client checks for 
updated software and firmware files located on the Fourier 
server, and if any have been detected they are downloaded 
and updated on the user’s computer. The user can also have 
DataNet automatically update the network units’ firmware or 
can choose to do so manually.  
A major benefit of the DataNet system is that units’ firmware is 
updated over the air or via USB from the DataNet software, so 
that the DataNet user does not have to ship any units back to 
the factory for upgrading. Without moving one deployed unit 
out of position in the network, the user can send a new 
firmware file wirelessly to all of the data logger end units and 
Repeaters. The Receiver firmware is updated via the USB 
cable.  
 
In addition to automatic firmware update, the user can also 
manually update the firmware via the DataNet Firmware 
Update Center or from the Logger/Repeater icon in Map View. 
Refer to the relevant sections in this chapter for more details. 
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6.1. Using the Uptodata Client 

Use the Uptodata client to perform automatic checks for 
updated DataNet software and firmware versions, including 
updated versions of this DataNet user guide. Once 
downloaded, DataNet software and firmware is automatically 
updated. However, you also have the option to manually 
update firmware rather than automatically.  
To use the Uptodata client follow the instructions below.  
1. Ensure the computer is connected to the Internet and 

launch DataNet. 
2. Launch the Uptodata update client from the DataNet 

main menu: Help > Check for Updates.  
3. You will be prompted to proceed to check for new 

updates. Click Next. The client will then check for updates 
on the server, including updates to the Uptodata client 
itself. 

 
Figure 67: Uptodata dialog  

 
4. Once the check is complete, any new updates will be 

displayed in the Uptodata dialog. Select the checkbox 
next to the file you wish to update and click Next. 
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5. The files will be downloaded to your default application 
directory. Click Finish to close the dialog once the 
download is complete. 

 
  

6. Click the Options  icon in the main Uptodata 
dialog for further options such as:  
• Checking for updates on startup (select Further 

Configurations menu item to modify frequency of 
update checking) 

• Automatic firmware update on startup 
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Figure 68: Uptodata configuration dialog 
 

Note: If the update was canceled for any reason and was not 
completed, none of the previous installation files will be 
affected. 

6.2. Updating DataNet 
Firmware 

There are several ways to update firmware for your DataNet 
hardware units. 
• Automatically, using the Uptodata client. Refer to section 

 6.1. 
• Manually, using the Firmware Update Center. Refer to 

section  6.2.2. 
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• Manually, using the context menu on the Logger/Repeater 
icons in the Map View. Refer to section  6.2.3. 

• Manually, via USB connection (for DNL910, DNL920, PA 
models and DNR900 only). 

6.2.1. Downloading the Firmware File 

1. There are two ways to obtain the DataNet firmware file.  
a. Using the Uptodata client to download from the 

Fourier server. Refer to section  6.1. 
b. Downloading the latest firmware version directly from 

the Fourier Download Center at: 
www.fouriersystems.com/support/download_center.php.  

2. Uptodata downloads the firmware file, named 
Firmware.dfw, to the DataNet directory on the computer. 
The default path is: C:\Program Files\Fourier 
Systems\DataNet. 

Note: The firmware file combines firmware for all DataNet 
hardware units into one file. There is no need to download 
separate files for each type of unit e.g. DNR800, DNR900, 
DNL910, DNL920, DNL910-PA. DNL-920-PA, DNL804, 
DNL808 and DNL810. 

 
If you download the firmware file from the Fourier 
Download Center make sure to copy the file to the same 
path listed above. 
 

Once the file is downloaded the next step is to update the 
DataNet units. 
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6.2.2. Using the Firmware Update 
Center 

To launch the Firmware Update Center: 
1. Once the downloaded firmware file is in the DataNet 

directory, go to Tools > Update Center from the main 
menu. Enter the password in the Password dialog to 
access the Update Center.  
If no firmware file is detected in the DataNet directory, 
then an error message is displayed and the Update 
Center opens with a blank screen.  

 
Copy the firmware file to the directory and reopen the 
Update Center. 

Note: The default password is 1234. 

2. The Update Center dialog lists all units in the network and 
displays pertinent information such as available firmware 
versions, firmware update status and unit info. 
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Figure 69: Firmware Update Center dialog 

 
3. If the unit status is Requires an update, then select the 

checkbox in the Update column adjacent to the unit you 
wish to update. You may select as many units as you like 
to update, but only two units can be updated at a time.  

4. As soon as you select the Update checkbox, the 
command will be sent to the unit to begin uploading the 
firmware. The firmware is first uploaded to the unit’s 
memory and then installed. Even if the update is stalled 
halfway due to the unit shutting down, for example, the 
unit will not lose its current firmware and so will continue 
to be operable.  

5. When the upload begins the Update Center status will 
change to Uploading firmware file and the unit display 
will read Loading firmware. The progress will also be 
displayed on both hardware and software. 
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6. When the upload is complete the unit will reset and the 

Update Center will display the status No update 
required. The firmware version will be updated as well. 

Note: You can quit the firmware update at any time by 
unselecting the Update checkbox in the Update Center. 

7.  When the unit resets it will automatically rejoin the 
network and will be in Stop mode. However the unit 
configuration will still be saved. For loggers which have 
completed firmware update, run the logger to start 
recording data again. 

 

Available Firmware Versions 
At the top of the Update Center dialog, available firmware 
versions are displayed. The information is taken from the 
firmware file Firmware.dfw stored in the DataNet directory 
C:\Program Files\Fourier Systems\DataNet. 

  
There are three classifications of DataNet units:  
• Receiver/ Repeater (DNR800 and DNR900) 
• DataNet data logger (DNL910, DNL920 and PA models) 
• Mini DataNet data logger (DNL804, DNL808 and 

DNL810) 
The same firmware file is used for all units.  
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Unit Status Options 
• Offline – unit is offline and firmware status can’t be 

determined. 
• No update required – Unit has latest firmware installed. 
• Uploading firmware file – Firmware file is being 

uploaded to the unit. Progress is displayed in 
percentages. 

• Updating firmware – Once firmware file is uploaded then 
the actual firmware update begins, overwriting the existing 
firmware on the unit. 

• Downloading – Logger unit is first downloading all data 
before beginning the firmware update.  

• Waiting to upload firmware – Unit is in a queue to 
upload the firmware, as the network can update two units 
at a time.  

 

Unit Information  
Additional information provided in the Update Center includes:  
• The unit comment/name 
• Serial number 
• Current firmware version 
• Unit status 
• Update progress 
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6.2.3. Firmware Update from the Map 
View Icon 

Each DataNet unit, the data logger, Receiver and Repeater, 
has the Update Firmware option in its Map View icon context 
menu.  
1. To perform a direct update from a specific unit, open the 

context menu and select Update Firmware. 
2. Enter the password in the Password dialog box. 
3. A DataNet system message will prompt you to confirm the 

update. Click Yes. 

 
4. The firmware will begin updating and you can monitor its 

progress in the unit’s tooltip as well as in the Firmware 
Update Center itself. 
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6.2.4. Firmware Update via USB  

All DataNet units with USB port can also be updated via direct 
USB to PC connection. Follow the instructions below. 

DNR900 Receiver 
1. Connect the DNR900 to the computer via USB. Go to 

Network > Detect Receiver in the DataNet main menu. 

2. Right-click on the Receiver icon  and select Update 
Firmware from the context menu. 

3. Enter the password in the Password dialog box. 
4. A DataNet system message will prompt you to confirm the 

update. Click Yes. 

 
5. The firmware will begin updating and you can monitor its 

progress in the unit’s tooltip. 
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DNR900 Repeater  
1. Make sure the DNR900 is in Repeater mode and joined to 

an existing network. When connected to the computer via 
USB go to Network > Detect Logger/Repeater in the 
DataNet main menu. 

2. Right-click on the Repeater icon  and select 
Update Firmware from the context menu. 

3. Enter the password in the Password dialog box. 
4. A DataNet system message will prompt you to confirm the 

update. Click Yes. 

 
5. The firmware will begin updating and you can monitor its 

progress in the unit’s tooltip. 

 
6. When complete, disconnect the USB cable and reconnect 

the Receiver to continue using the DataNet system. 
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DNL910, DNL920 and PA Data Loggers  
1. Make sure the data logger is joined to an existing 

network. When connected to the computer via USB go to 
Network > Detect Logger/Repeater in the DataNet main 
menu. 

2. Right-click on the logger icon  and select Update 
Firmware from the context menu. 

3. Enter the password in the Password dialog box. 
4. A DataNet system message will prompt you to confirm the 

update. Click Yes. 

 



 
 

224 

5. The firmware will begin updating and you can monitor its 
progress in the unit’s tooltip. 

 
6. When complete, disconnect the USB cable and reconnect 

the Receiver to continue using the DataNet system. 

6.2.5. Cancelling Firmware Update 

To cancel a firmware update, right-click the unit’s icon in the 
Map View and select the Cancel Firmware Update option. 
If a data logger was in Run mode prior to the firmware update, 
when cancelling it the logger will resume operation in Stop 
mode. 

6.2.6. Interrupted Firmware Update  

There are several ways an in progress firmware update may 
be interrupted:  
• Unselecting the checkbox next to the unit name in the 

Firmware Update Center  
• Disconnecting the USB from the Receiver  
• Disconnecting the USB from the Repeater or data logger 

during update via USB 
• Exiting the DataNet software 
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In each case, when the unit is back online the firmware 
update will automatically resume (from the beginning of the 
update). 
If a data logger’s firmware update was interrupted, and it was 
in Run mode prior to the update, the logger will continue to 
run even after the interruption. 
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Appendix A:  
DataNet Specifications 

A.1. Data Logger Input Types 

DNL910, DNL920 and PA Models 
External Inputs 
Four external inputs with selectable 
sensor type for each input:  
• 4 to 20 mA 
• 0 to 1 V 
• 0 to 50 mV 
• PT-100 (2-wire) 
• Contact (Open/Closed) 
• Thermocouple J, K or T 
• Pulse counter (Input 4 only) 
• Frequency (Input 4 only)  
• User-defined sensors 

Internal Inputs 
DNL910 
• PT-100 Temperature 
DNL920 
• Digital Temperature 
• Digital Relative Humidity 

DNL804 
External Input  
Current 4 to 20 mA 

Internal Inputs 
None 

DNL808 
External Input  
NTC 10 KΩ 

Internal Inputs 
None 
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DNL810  
External Input 
None 

Internal Inputs 
Digital Temperature 
Digital Humidity 

A.2. DNL910 and DNL920 
Outputs   

Alarm Output (Output 1) External Power Excitation 
(transducers usage) 

Open collector 
Close position resistance: 50 Ω 
Max. Load: 50 mA, 3 V DC 
Overload protection 
50 mA reset fuse 

12 VDC @ 2 A 

A.3. Logger Input 
Specifications DNL910, 
DNL920 and PA models 

Internal PT-100 
Temperature  

(DNL910) 

Internal Digital 
Temperature  

(DNL920) 

Internal Digital  
Relative Humidity 

(DNL920) 

Type: PT-100 
Range: -20 to 50 ˚C 
Resolution: 0.1 ˚C  
Accuracy: ±0.3 ˚C 

Type: Digital sensor 
Range: -20 to 50 ˚C 
Resolution: 0.1 ˚C  
Accuracy: ±0.5 ˚C 

Range: 5 to 95 % 
Resolution: 0.5% 
Accuracy: 3% (software) 
4% (Logger LCD) 
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Temperature 
Thermocouple J 

Temperature 
Thermocouple K 

Temperature 
Thermocouple T 

Range: -200 to 1,000 ˚C 
Resolution: 0.1 ˚C  
Accuracy: 
-200 to – 60 ˚C ±0.5 % 
60 to 1,000 ˚C ±0.5 % 
-60 to 60 ˚C ±0.5 ˚C 
Cold junction 
compensation: ±0.3 ˚C 

Range: -200 to 1,000 ˚C 
Resolution: 0.1 ˚C  
Accuracy:  
-200 to – 60 ˚C ±0.5 % 
60 to 1,000 ˚C ±0.5 % 
-60 to 60 ˚C ±0.5 ˚C 
Cold junction 
compensation: ±0.3 ˚C 

Range: -200 to 400 ˚C 
Resolution: 0.1 ˚C  
Accuracy:  
-200 to – 60 ˚C ±0.5 % 
60 to 400 ˚C ±0.5 % 
-60 to 60 ˚C ±0.5 ˚C 
Cold junction 
compensation: ±0.3 ˚C 

Temperature PT-100 
(2-wire) 

Pulse Counter  
(Input 4 only) 

Frequency  
(Input 4 only) 

Range: -200 to 400 ˚C 
Resolution: 0.1 ˚C) 
Accuracy:  
-200 to - 60 ˚C ±0.5 % 
60 to 400 ˚C ±0.5 % 
-60 to 60 ˚C ±0.3 ˚C 

Range: 1 to 65,536 
counts 
Resolution: 1 count 
Frequency range: 0 to 4 
KHz 
Input signal: 0 to 5 V 
Input impedance: 470 Ω 

Range: 20 Hz to 4 KHz 
Input signal: 0 to 5 V 
Input impedance: 470 Ω 
 
 

4 to 20 mA 0 to 1 V 0 to 50 mV 

Range: 4 to 20 mA 
Resolution: 4.76 μA 
Accuracy: ±0.5 % 
Loop impedance: 21 Ω 
Maximum load: 30 mA, 
5.2 V 

Range: 0 to 1 V 
Resolution: 200 μV 
Accuracy: ±0.5 % 
Input impedance: 25 
MΩ 
Maximum voltage: 5.2 V 

Range: 0 to 50 mV 
Resolution: 3 μV 
Accuracy: ±0.5 % 
Input impedance: 25 
MΩ 
Maximum voltage: 5.2 V 

Contact   

Range: Open/Close   
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A.4. Mini DataNet Sensor 
Specifications  

Current 
(DNL804) 

NTC 10 KΩ  
(DNL808) 

Range: 4 to 20 mA 
Resolution: 1.16 uA 
Accuracy: 0.5 % 
 

Range: -50 to 150 °C 
Resolution: 0.06 °C 
Accuracy:  
-50 to 60 ˚C ±0.3 ˚C 
60 to 150 ˚C ±0.5 % 

Internal Digital 
Temperature  

(DNL810) 

Internal Digital  
Relative Humidity 

(DNL810) 
Temp range: -20 to 50 °C 
Temp resolution: 0.04 °C 
Temp accuracy: ±0.4 °C 

RH range: 5 to 95 % 
RH resolution: 0.5 % 
RH accuracy: ±3 % 

A.5. General Specifications 

DataNet Logger Sampling Features 
• Memory capacity:  ~59,000 samples 
• Sampling rate:  Once every second to once every 18  

 hours 
• Sampling resolution: 16-bit 
• Channel separation:  80 dB 
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DataNet RF Network Communication  
• Frequency: 2.4 GHz 
• Network units: 65,000 
• Data rate: 250 Kbps 
• Full mesh network architecture supported 
• 128-bit network security encryption 
• Worldwide license-free 
• Transmission strength: 

 DNR800: 10 dBm 
 DNR900: 15 dBm 
 DNL804, DNL808 and DNL810: 4 dBm 
 DNL910 and DNL920: 4 dBm 
 DNL910-PA and DNL920-PA: 15 dBm 

 

DNR900, DNL910, DNL920, DNL910-PA and 
DNL920-PA Hardware Specifications  
Display  
• 2-row LCD 
• 16 character display 
 

Power Supply  
• Battery:  

• Internal rechargeable 4.8 V, 800 mAh  NiMH battery 
(2 batteries in series) 

• Built-in battery charger 
• Battery Life: Up to six months * 
* PA models have battery life of up to three hours  
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• AC Power: 
• External 12 V DC input @ 300 mA 3.6 VA 
• Center Negative 

   

Operating Temperature Range 
• -20 to 50 ˚C 
• Water and dust proof: IP54 
 

DNR900 PC Communication 
• USB 2.0 compliance 
• Mini USB type B cable 
Casing 
• Plastic ABS box 
• Dimensions: 97 x 93 x 27 mm   
• Weight: 200 gr  
• Table and wall mounting 
 

DNR800 Hardware Specifications 
Power Supply  
• External 12 V DC input @ 300 mA 3.6 VA 
• Center Negative  
 
Casing 
• Dimensions: 68 x 68.6 x 26.5 mm (without the cradle and 

the external antenna) 
• Weight: Device: 61 gr; Cradle: 10 gr; External Antenna: 

17.5 gr 
• Table and wall mounting 
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Operating Temperature Range 

• -30 to 75 ˚C 
• Water and dust proof: IP54 

 

DNL804, DNL808 and DNL810 Hardware 
Specifications 
Power Supply 
• Internal 2/3 AA lithium battery 
• Battery voltage range: 2V - 3.6 V 
• Battery life: Up to 10 months depending on sampling rate  
 

Casing 
• Dimensions: 68 x 68.6 x 26.5 mm (without the cradle and 

the external antenna) 
• Weight: Logger: 53 gr; Cradle: 10 gr; External Antenna: 

17.5 gr 
• Table and wall mounting 
 

Operating Temperature Range 
• -30 to 75 ˚C 
• Water and dust proof: IP54 
 

Man Machine Interface 
Full keyboard operation 
  

Standards Compliance 
CE, FCC 
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A.6. System Requirements 

Software Hardware 

OS Platform: Windows 2000 SP3, 
Windows 2003, Windows XP SP2, 
Windows Vista (32-bit) and Windows 7 
(32-bit) 
Browser: Internet Explorer 5.01 or higher 
Screen Resolution: Minimum 1024 x 768 

Processor: Pentium 800 MHz or 
higher  
Memory: 256 MB RAM  
Storage Memory: 250 MB available 
disk space for the DataNet application 
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Appendix B:  
DataNet Mounting 
Diagrams 

This appendix includes mechanical diagrams of the DNL and 
DNR DataNet models. The diagrams include dimensions to be 
used as a reference for mounting the units on the wall. 

Rear Casing Dimensions for DNL9XX and 
DNR9XX Wall Mounting 
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Cradle Dimensions for DNL8XX and DNR800 
Wall Mounting 

 

 

 



 
 

236 

Appendix C:  
Safety Information and 
FCC IDs 

The DataNet system complies with relevant safety regulations 
for data processing devices. Please contact Fourier Systems 
with any questions regarding DataNet safety issues.  

Note: The manufacturer is not responsible for any radio or TV 
interference caused by unauthorized modifications to this 
equipment. Such modifications could void the user’s authority 
to operate the equipment. 

 

FCC ID for DataNet System 
DNR900: 

FCC ID: XGO-DNR9XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.

 

DNL910: 
FCC ID: XGO-DNL9XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  
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DNL920: 
FCC ID: XGO-DNL9XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.

 

DNR800: 
FCC ID: XGO-DNR8XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  

DNL910-PA 
FCC ID: XGO-DNL9XX-PA
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  

DNL920-PA 
FCC ID: XGO-DNL9XX-PA
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  

DNL804: 
FCC ID: XGO-DNL8XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  

DNL808: 
FCC ID: XGO-DNL8XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  
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DNL810: 
FCC ID: XGO-DNL8XX
This device complies with Part 
15 of the FCC Rules. Operation 
is subject to the following two 
conditions:
(1) This device may not cause 
harmful interference and
(2) This device must accept any 
interference received, including 
interference that may cause 
undesired operation.  

 

 

DataNet Battery 
The DataNet DNR900, DNL910, DNL920, DNL910-PA and 
DNL920-PA devices are supplied with internal rechargeable 
4.8 V NiMH batteries as well as connection to AC power. 
The Mini DataNet DNL804, DNL808 and DNL810 data 
loggers are supplied with 1 x 2/3 AA lithium battery. 
 
• Do not tamper or drop the battery to avoid leakage of 

hazardous chemicals contained within.  
• Do not puncture, incinerate, disassemble or expose the 

battery to temperatures above 122 ºF (50 ºC). 
• Keep the battery away from children. 
• Dispose of the battery only in accordance with local 

regulations concerning potentially hazardous waste. Do 
not throw in the garbage bin. 

• Remove the battery when not using the DataNet loggers 
for a significant period of time e.g. when the DataNet 
loggers are placed in long-term storage.  
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DataNet AC Power Adapter 
• Only use the AC adapter provided by Fourier Systems. 
• Verify that your power outlet is suitable for the voltage of 

the AC adapter. 
• If the AC adapter is connected to an AC outlet, make sure 

the area around the outlet is accessible and the adapter is 
not covered while in operation. 

• Do not place the AC adapter on heat-sensitive material. 
• Do not charge the DataNet while situated in a carrying 

case or without sufficient airflow surrounding the loggers. 
• Do not expose the adapter to direct sunlight or water. 
• Do not tamper with the adapter components. 
 
DataNet Operating Environment 
• DNR900, DNL910, DNL920, DNL910-PA and DNL920-

PA: -20 to 50 ˚C 
• DNR800, DNL804, DNL808 and DNL810: -30 to 75 ˚C 
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Appendix D:  
Ordering Information 

For the full list of DataNet products, and place DataNet orders 
please visit www.fouriersystems.com/order or contact your 
local Fourier distributor: 

DataNet Product Suite 
Part Number Product Name Product Description 

DNR900 

 

Receiver/Repeater Two-mode module for creating 
and managing DataNet ZigBee 
network, and extending network 
transmission range 

DNR800 

 

Mini Repeater • Module for extending 
network transmission range 

• External AC power supply 
only 

DNL910 

 

Temp. Data Logger
  

• Internal Temperature PT-
100 sensor 

• Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

DNL920 

 

Temp/RH Data Logger • Internal Digital RH and 
Temperature sensors 

• Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 
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Part Number Product Name Product Description 
DNL910-PA 

 

Temp. Data Logger 
with Power Amplifier 
  

• Internal Temperature PT-
100 sensor 

• Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

• Includes Power Amplifier 
for long-range transmission 

DNL920-PA 

 

Temp/RH Data Logger 
with Power Amplifier 

• Internal Digital RH and 
Temperature sensors 

• Four channels: mA, V, mV, 
TC-K/J/T, PT-100, Pulse, 
Frequency, Contact 

• Includes Power Amplifier 
for long-range transmission  

DNL810 

 

Mini DataNet 
Temp/RH Logger 

• Internal Digital Temperature 
and Humidity sensors 

• Battery operated 

DNL808 

 

Mini DataNet External 
Temp. Logger 

• External NTC 10 KΩ 
Temperature input with 
NTC probe 

• Battery operated 
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Part Number Product Name Product Description 
DNL804 

 

Data Logger • External 4-20 mA input 
• Battery operated 

DN-PCSUITE 

 

 

Software CD and 
Accessories 

PC Suite including USB 
communication cable, software 
CD and digital user guide 

12504 

 

GSM Modem GSM modem connecting to PC 
and integrates with DataNet 
software to enable sending of 
SMS alarm notifications 

DT332 

 

NTC temperature 
sensor and cable 

NTC 10 kΩ temperature sensor 
for use with DNL808 
• Range: -50 to 150 °C  
• 2.5 m cable length 

12753 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor  
• Range: -70 to 400 °C   
• 2.5 m cable length 

12752 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor  
• Range: -70 to 400 °C   
• 4 m cable length 
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Part Number Product Name Product Description 
12751 

 

PT-100 temperature 
sensor and cable 

PT-100 temperature sensor  
• Range: -70 to 400 °C   
• 6 m cable length 

12655 
 
 
 

1 m mini-USB 
communication cable 

For connection between 
Receiver and PC 

13330 
 
 
 

3 m mini-USB 
communication cable 

For connection between 
Receiver and PC 

12928 

 

Replacement internal 
battery (for Mini 
DataNet) 
 

• Replacement internal 
battery for DNL808 and 810 

• 2/3 AA 3.6 V lithium  
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